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Welcome to your printer

Your printer is a color inkjet printer designed for fast, consolidated monochrome and color printing; and also
scanning and copying, if you have the MFP model. Some major features:

Print up to 6 D/A1 pages/min in monochrome and color; first page out in 30 s.

e [fyou have an MFP model, you can print, scan, and copy with a single device—including an integrated 1200
dpi scanner.

e  Single, easy-to-use device.

e  Upto fourrolls with a 100-page integrated stacker.

e  Run at costs comparable to low-volume.

e  Produce excellent technical documents: crisp lines, fine detail, and smooth grayscales.

e  HPPageWide XL pigment ink for dark blacks, vivid colors, and moisture/fade resistance, even on uncoated
bond paper.

e  Print on a wide range of papers up to 40 in (101.6 cm) wide, covering ISO/US technical and offset
standards.

e  Protect and manage confidential jobs more securely—retrieve documents at the printer with a PIN.

e  Help safeguard confidential information using a self-encrypting hard disk drive with AES-256, Secure Disk
Erase, and IPsec.

e  Reduce the time and cost of managing individual drivers by using the HP DesignJet Universal Print Driver.

Safety precautions

Before using your printer, read, understand, and follow these safety precautions, and your local Environmental,
Health, and Safety regulations, to make sure you can use the equipment safely.

You are expected to have the appropriate technical training and experience necessary to be aware of hazards to
which you may be exposed in performing a task, and take appropriate measures to minimize the risks to yourself
and to other people.

General safety guidelines

2 Chapter 1

There are no operator-serviceable parts inside the printer except those covered by HP's Customer Self
Repair program (see http://www.hp.com/go/selfrepair/). Refer servicing of other parts to qualified service
personnel.

Turn off the printer and call your service representative in any of the following cases:
—  The power cord or plug is damaged.

—  Thedrying enclosures are damaged (Asia-Pacific and Japan only).

—  The printer has been damaged by an impact.

—  Thereis any mechanical or enclosure damage.

Introduction ENWW


http://www.hp.com/go/selfrepair/

Liguid has entered the printer.

There is smoke or an unusual smell coming from the printer.

The printer has been dropped.

The drying module has been damaged (Asia-Pacific and Japan only).

—  The printer is not operating normally.

e  Turn off the printer in either of the following cases:
—  During a thunderstorm
—  During a power failure
e  Take special care with zones marked with warning labels.
Electrical shock hazard

AWARNING! The internal circuits of the built-in power supplies and power inlet operate at hazardous voltages
capable of causing death or serious personal injury.

/\ WARNING!  The internal circuits of the drying system (Asia-Pacific and Japan only) operate at hazardous
voltages capable of causing death or serious personal injury.

The printer uses one power cord. Unplug the power cord before servicing the printer.

To avoid the risk of electric shock:

The printer must be connected to earthed mains outlets only.

Do not attempt to dismantle the drying modules (Asia-Pacific and Japan only).
Do not remove or open any other closed system covers or plugs.

Do not insert objects through slots in the printer.

Take care not to trip over the cables when walking behind the printer.

Heat hazard (Asia-Pacific and Japan only)

ENWW

The printer’s drying subsystem operates at high temperatures and can cause burns if touched. To avoid personal
injury, take the following precautions:

Let the printer cool down before accessing the paper output area in case of a paper jam.

Let the printer cool down before performing some maintenance operations.

Safety precautions
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Fire hazard
The internal parts of the printer’s drying subsystem (Asia-Pacific and Japan only) operate at high temperatures.
To avoid the risk of fire, take the following precautions:

e  The customer is responsible for meeting the printer's requirements and the Electrical Code requirements
according to the local jurisdiction of the country where the equipment is installed. Use the power supply
voltage specified on the nameplate.

e  Use only the power cord supplied by HP with the printer. Do not use a damaged power cord. Do not use the
power cord with other products.

e Donotinsert objects through slots in the printer.

e  Take care not to spill liquid on the printer. After cleaning, make sure all components are dry before using
the printer again.

e Do not use aerosol products that contain flammable gases inside or around the printer. Do not operate the
printer in an explosive atmosphere.

e Do not block or cover the openings of the printer.

e Do not attempt to dismantle or modify the drying modules (Asia-Pacific and Japan only).

Mechanical hazard

The printer has moving parts that could cause injury. To avoid personal injury, take the following precautions
when working close to the printer:

e  Keep your clothing and all parts of your body away from the printer's moving parts.

e  Avoid wearing necklaces, bracelets, and other hanging objects.

e Ifyour hairis long, try to secure it so that it will not fall into the printer.

e  Take care that sleeves or gloves do not get caught in the printer's moving parts.

e Do not operate the printer with covers bypassed.

e Do not try to dismantle the cutter assembly: refer servicing to qualified service personnel.

e Do not stand on the drawers: the printer could fall over.

Light radiation hazard

Light radiation is emitted from the beacon, ink level indicators, paper drawer indicators, and formatter status
indicators. The emitted light is in compliance with the requirements of the exempt group of IEC 62471:2006,
Photobiological safety of lamps and lamp systems. Do not modify these modules.
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Heavy paper hazard
Special care must be taken to avoid personal injury when handling heavy rolls of paper.

e Handling heavy rolls may require more than one person. Care must be taken to avoid back strain and/or
injury.

e  Consider using a forklift, pallet truck, or other handling equipment.
e  When handling heavy rolls, wear personal protective equipment including boots and gloves.

e Do not exceed the maximum weight of a paper roll: see Functional specifications on page 178.

Paper rolls could weigh up to 18 kg. Follow your local Environmental Health and Safety recommendations for
handling heavy paper rolls.

Ink handling

HP recommends that you wear gloves when handling the ink maintenance cartridge or waste container.

Warnings and cautions

The following symbols are used in this manual to ensure the proper use of the printer and to prevent the printer
from being damaged. Follow the instructions marked with these symbols.

AWARNING! Failure to follow the guidelines marked with this symbol could result in serious personal injury or
death.

A CAUTION:  Failure to follow the guidelines marked with this symbol could result in minor personal injury or
damage to the printer.

Warning labels

Label Explanation

Electric shock hazard. Heating modules operate at hazardous
ELECTRIC SHOCK HAZARD voltages. Disconnect power cord before servicing.

Heating modules operate at hazardeus vollages.
Disconnect all power sources before servicing.

Caution! Double pole. Neutral fusing, CAUTION: Double Dole. Neutral fUSing.

Before sfarling, read and follow the operating
and safety instructions.

L e e e Before starting, read and follow the operating and safety

de et de sécurité : :
Lesen und befolgen Sie bitte die Bedienungs- und instructions.

Sicherheitsanweisungen, bevor Sie starten.
Antes de empezar, lea y siga las instrucciones sobre
funcionamiento y seguridad.

Fraehl , WL TR IR S B,

TERMEZ B, SESERNINALARERIRE T S 4E5 31T,
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Label Explanation

Crush hazard. Keep hands away from the moving service carriage.

This label is located by the access to the service carriage, on the gas
springs, and in the folder.

You are recommended to wear gloves when handling the cleaning
container.

This label is located on the cleaning container and by the access to
the service carriage.

Do not use the drawers as stairs: the printer could overbalance.

This label is located on the drawers.

Do not touch the starwheels: they are fragile.

This label is located on each side of the output area.

[%9 NOTE: The final label position and its size on the printer may vary slightly, but labels should always be visible
and close to the potential risk area.

Chapter 1 Introduction ENWW



Main components

The following front and rear views of the printer illustrate the main components.

Front view

1. Printbar

2. Front panel

3. Inkcartridges

4.  Paper access front cover
5. Drawer

6.  Maintenance cartridge

Rear view

1. Output module

2. Paper output

3. Power switch and plug

ENWW Main components 7



4. LAN connections

5. (Cleaning container

Front panel

The front panel is a touch-sensitive screen with a graphical user interface, located on the front right of the
printer. It can rotate 360 degrees horizontally, so you can use it from the front or rear of the printer. It can also be
tilted to minimize reflections.

It gives you complete control of your printer: from the front panel, you can view information about the printer,
change printer settings, monitor printer status, and perform tasks such as supplies replacement and
calibrations. The front panel displays alerts (warning and error messages) when necessary.

?

T ! ]
L )
—9
(2
I —6
©; 0O
NS )

N 4

It includes the following components:

1. AHi-Speed USB host port, intended for connecting a USB flash drive, which can provide files to be printed or
a destination for scanned files. When a USB flash drive is inserted, a USB icon is displayed on the

front panel's home screen.
2. The front panel itself: an 8 inch, full-color, touch-sensitive screen with a graphical user interface.
3. Aloudspeaker.

4.  The Power key, with which you can turn the printer on or off, or wake up from sleep mode. The key is
illuminated when the printer is on. It flashes when the printer is in sleep mode.

5. The beacon, which enables you to see printer status and alerts from a distance.

The front panel has a large central area to display dynamic information and icons. On the left and right sides you
can see up to four fixed icons at different times. Normally they are not all displayed at the same time.

Left and right fixed icons

e Tap @ to return to the home screen.

e Tap |84 to view help about the current screen.

8 Chapter 1 Introduction ENWW



e Tap to go back to the previous screen. This does not discard any changes made in the current screen.

o Tap P to cancel the current process.

Home screens

There are three top-level screens that you can move between by sliding your finger across the screen, or tapping
the appropriate button at the bottom of the screen:

e  The first main screen provides direct access to the important printer functions, depending on your printer
model and accessories.

MFP screen
@ Ready "

R

Print Scan Copy Job queue

L =
e  Theall-app screen displays a list of all apps available in your printer, and the status of each of them.

& Ready i

© & =

Paper Ink Optimize quality Connectivity

About printer Usage Settings User's guide
A =
-

e The widget screen enables you to monitor at a glance supplies such as ink and paper, the job currently
being printed, and the job queue.

=\ A04_Floor on hold for paper

) Upnext o
:if:"ui?m?‘p e v — Now printing
nn Smith SR 00:10:73

@ Nowprinting
PresentationV6
tin Jones

PAGES

06/100

On hold 1 COPIES TOTAL
A0S Roar 02/10 1.000

Albert Davis

HP Universal Plain Paper =
Bond Paper (>110gsm)
36" 36"
Plain Paper Heavy Weight
(<90gsm) Coated 3 . LL
36" 24" ¢ K v M

A~
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Printer alerts

The printer has a beacon located on top of the front panel; it gives a summary of the printer status that can be

seen from a distance.

M IMPORTANT:  The information provided in the beacon is for functional information purposes only, and is not
relevant to your safety. Warning labels on the printer must be always considered when operating the printer,
regardless of the status indicated by the beacon lights.

White light

White moving light

Yellow end light

Yellow light

Red light

The printer is ready.

The printer is printing or preparing to print.

The printer will need attention soon: for example, it is almost out of ink or
paper. When printing, the yellow light remains at the left, and a white
moving light appears.

The printer can print, but there is something wrong. If the problem persists,
contact your support representative. While printing, you will see a yellow
instead of a white light.

The printer is unable to print and needs attention, or a major subsystem of
the printer is not working.

You can change the beacon settings by tapping @ , then System > Beacon. For example, you can change the

brightness of the beacon. You can also turn off beacon warnings and show only definite errors.

Chapter 1 Introduction
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Dim mode

After some time with no activity (5 minutes by default), the printer goes to dim mode, which reduces the
brightness of the front panel by 25% and the brightness of the beacon by 10%. Any activity, such as the use of
the front panel or the arrival of a print job, ends dim mode and restores normal brightness. After some time in
dim mode (15 minutes by default), the printer changes to sleep mode. The time periods can be changed from
the front panel. See Sleep mode on page 11.

Sleep mode

Sleep mode puts the printer into a reduced power state after a period of inactivity, turning off some elements to
save energy. Printer features can be enabled from this mode, and the printer maintains network connectivity,
waking up only as necessary.

The printer can be woken from sleep mode in any of the following ways:
e By pressing the power button

e  Byopening adoor or drawer

° By sending a print job

e  Byinserting a page into the scanner (MFP only)

The printer wakes up in several seconds, more quickly than if it is completely turned off. While in sleep mode, the
power button blinks.

To change the time that elapses before sleep mode, see Change system options on page 117.

Printer Monitoring (with the Print Spooler) and Remote Printer Management with the HP Utility and Web
JetAdmin continue to be available during sleep mode. Some remote management tasks offer the option of
remotely waking up the printer if needed to perform the task.

Change the language of the front-panel display

There are two possible ways to change the language of the front-panel menus and messages:
e Ifyou can understand the current front-panel display language, tap {é} , then System > Language .

e Ifyou cannot understand the current front-panel display language, start with the printer powered off. Press
the power key to turn it on. When you see icons appear on the front panel, tap @ and then . The
front panel acknowledges this sequence by turning the icons on and off rapidly.

Whichever method you used, the language selection menu should now appear on the front-panel display. Tap
your preferred language.

The available languages are English, Portuguese, Spanish, Catalan, French, Dutch, Italian, German, Polish,
Russian, Simplified Chinese, Traditional Chinese, Korean, and Japanese.
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Change system options

You can change various printer system options from the front panel. Tap @ , then System.

Date and time options to view or set the printer's date and time.

Speaker volume to change the volume of the printer's loudspeaker. Select Off, Low, or High.

Front panel brightness to change the brightness of the front-panel display. The default brightness is 50.
Beacon > Beacon to change the brightness of the beacon. Select High, Medium, Low, or Off.

Beacon > Notify warning alerts to turn warning alerts on or off.

Power options > Printer sleep to change the length of time the printer waits before going into sleep mode
(see Sleep mode on page 11). You can set the time from 5 to 240 minutes. The default time is 20 minutes
(total time including 5 minutes in dim mode).

Unit selection to change the units of measurement in the front-panel display. Select English or Metric. By
default, units are set to Metric.

Restore factory settings to restore the printer settings to their original values as set in the factory. This
option restores all of the printer settings except the Gigabit Ethernet settings and paper presets.

HP Utility

The HP Utility enables you to manage your printer from a computer with a TCP/IP connection.

[%/]’9 NOTE: The HP Utility under Mac 0S X and the HP DesignJet Utility under Windows have similar functions and
are sometimes referred to collectively as the HP Utility in this guide.

12 Chapter 1

Under Windows, start the HP DesignJet Utility from the [ icon on your taskbar or from Start > All
Programs > HP > HP DesignJet Utility > HP DesignJet Utility. This launches the HP DesignJet Utility, showing
the printers installed on your computer. When you open the HP DesignJet Utility for the first time, it may
offer you an automatic update with enhanced functionality that we recommend you to accept.

Under Mac 0S X, launch the HP Utility from your Dock shortcut or by clicking Applications > HP > HP Utility.
This launches the HP Utility, showing the printers installed on your computer.

When you select your printer in the left pane, everything that appears in the right pane is specific to that
printer.

() HP Designjet Utility

DEVICES Q| OVERVIEW

SUPPLIES ALERTS

PRINTER DETAILS

HP Designjet T930 36-in PostScript® ePrinter ESTIMATED INK LEVELS . Paper path out of paper. Job interrupted.

83% 7B% 83% 6% 2% 9%

'El K G mk C M ¥

Estimate only, actual ink levels may vary.

HP Designjet T520 36in

Printer Ready @
PAPER INUSE

Product Number: Serial Number:
L2¥228 (N3340H019 Sl Fapeyme:
[FW Version: Connection:
MRYPLUS 03_00_0 IP(15.196.4.126)
9.2

Width:

HP Designjet T930
PostScript
(15.196.4.126)
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Embedded Web Server

ENWW

The Embedded Web Server is a Web server running inside the printer. You can use it to obtain printer
information, manage settings and presets, install new firmware, and troubleshoot problems. Service engineers
can use it to retrieve internal information that helps to diagnose printer problems.
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| WP Part number
Ful % FBI4A - HP 841

oK % FRUATA - HP 841

You can access the Embedded Web Server remotely by using an ordinary Web browser running on any computer..
The following browsers are known to be compatible with the Embedded Web Server:

e  Microsoft Internet Explorer 8 and later for Windows 7 and later

e  Apple Safari 6 and later for OS X 10.8 and later

e  Mozilla Firefox 36 and later

e  Google Chrome 41 and later

Make a note of your printer's IP address, which you can see on the front panel by tapping the icon, then

Network.

To use the Embedded Web Server on any computer, open your Web browser and enter the printer's IP address in
the browser's address bar.

€ (e =zm 2 @newtes 1l

File Edit View Favorites Tools Help

The Embedded Web Server window displays five separate tabs. A button near the top of each page provides
access to online help.

The Embedded Web Server functions in the following languages: English, Portuguese, Spanish, Catalan, French,
Dutch, Italian, German, Polish, Russian, Simplified Chinese, Traditional Chinese, Korean, and Japanese. It uses the
language that you specified in your Web browser options. If you specify a language that it cannot support, it
functions in English.
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To change the language, change your Web browser's language setting. For example, in Chrome, click Settings >
Language (in the advanced settings view), and make sure that the language you want is at the top of the list in
the dialog box; or, in Internet Explorer version 8, go to the Tools menu and click Internet Options > Languages.
Make sure that the language you want is at the top of the list in the dialog box.

To complete the change, close and reopen your Web browser.

Turn the printer on and off

If you wish to turn the printer on or off or reset the printer, the normal and recommended method is to use the
power key on the front panel.

o ]
i N\
(©)
\8 /

R Z

However, if you plan to store the printer for a long period or the power key does not seem to work, you are
recommended to turn it off using the power switch at the rear.

To turn it back on, use the power switch at the rear.

When the printer is powered back on, it takes about 3 minutes to initialize and check and prepare the print bar.
Preparing the print bar takes about 75 seconds. However, if the printer has been off for 2 weeks or more,
preparing the print bar could take up to 7 minutes, plus 13 minutes if it needs a printhead recovery.

See also Sleep mode on page 11.
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Internal prints

The internal prints give various kinds of information about your printer. They can be requested from the front
panel.

Before requesting any internal print, check that the printer and the paper are ready for printing.

The loaded paper should be at least A3 landscape—420 mm (16.53 in) wide—otherwise the print may be
clipped.

The front panel should be displaying the Ready message.

To print any internal print, tap @}\ , then scroll down to Internal prints and tap it, then select the internal print

you want. The following internal prints are available:

ENWW

Demo prints show some of the capabilities of the printer
—  Print drawing demo

—  Print rendering demo

—  Print GIS map

User information prints

Usage report shows estimates of the total number of prints, number of prints by paper type, number
of prints by print-quality option, counting of scans, and total amount of ink used per color (the
accuracy of these estimates is not guaranteed)

HP-GL/2 palette shows the color or grayscale definitions in the currently selected color palette

PostScript font list shows PostScript fonts available (PostScript printers only)

Print folder pattern

Service information prints

—  Print current information

—  Print usage information

—  Print event logs

—  Print calibration status

—  Print connectivity configuration

—  Printall pages (prints all the above reports)
Output destination prints

—  Print test on folder to check alignment

—  Print test on stacker to test alignment

Internal prints

15



Preparing your printer

Connect the printer to your network

The printer is able to configure itself automatically for most networks, in a similar way to any computer in the
same network. The first time you connect it to a network, this process may take a few minutes.

Once the printer has a working network configuration, you can check its network address from the front panel:

X TIP: Consider making a note of the printer’s network name and IP address, because you may need them during
the setup process of connecting your Windows or Mac OS computer clients.

- Network G
@

Gigabit Ethernet

Status:

Bonjour name:

Host name:

Bonjour domain name:
MAC address:

Protocol name:

| 1P address |

Config. by:

Modify network configuration

Ethernet. From here it is possible, though not normally necessary, to change the settings manually; this can also
be done remotely using the Embedded Web Server.

For full details of the available connectivity settings, see Networking on page 84.

If you accidentally misconfigure the printer's network settings, you can restore the network settings to their

&3] . then {3 . then Restore factory settings. Then you

must restart the printer. This automatically provides a working network configuration for most networks. The
printer's other settings remain unchanged.

Connect a computer to the printer by network (Windows)

The following instructions apply if you intend to print from software applications using a printer driver. See
Sending a job to print on page 94 for alternative ways of printing.
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Before you begin, check your equipment:
e  The printer should be set up and on.
e  The Ethernet switch or router should be on and functioning correctly.

e  The printer and the computer should be connected to the network (see Connect the printer to your network
on page 16).

Now you can proceed to install the printer software and connect to your printer.

Printer software installation

1. Make a note of the printer’s host name and IP address from the front panel (see Embedded Web Server
on page 13).

2. Download the printer software from HP's website at http://www.hp.com/go/pagewidexlseries/support/
drivers.

3. Select Windows or Mac 0S X software, and choose which specific software you want to install (by default,
all of it).

4. Once downloaded, open it, and follow on-screen steps.

If your computer fails to find any printers on the network, the Printer Not Found window is displayed, which helps
you to try to find your printer. If you have a firewall in operation; you may have to disable it temporarily in order
to find the printer. You also have the options of searching for the printer by its hostname, IP address or MAC
address.

Uninstall the printer software (Windows)

Use the Control Panel to uninstall the software, in the same way as you can uninstall any other software.

Connect a computer to the printer by network (Mac 0S X)
You can connect your printer to a network under Mac OS X by using the following methods:
e  Bonjour

e TCP/IP

[ NOTE:  The printer does not support AppleTalk.

The following instructions apply if you intend to print from software applications using a printer driver. See
Sending a job to print on page 94 for alternative ways of printing.

Before you begin, check your equipment:
e  The printer should be set up and on.
e  The Ethernet switch or router should be on and functioning correctly.

e  The printer and the computer should be connected to the network (see Connect the printer to your network
on page 16).

Now you can proceed to install the printer software and connect to your printer.
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Go to the front panel and tap . Note the mDNS service name of your printer.

Access the install package from HP's website: http://www.hp.com/go/pagewidexlseries/support/drivers. If
prompted, select your printer from the list.

When the PageWide Printer window appears on your screen, click Software and drivers.

Select Windows or Mac 0S X software, and choose which specific software you want to install (by default,
all of it).

When the software has been installed, the HP Utility starts automatically, to set up a connection to your
printer. Follow the instructions on your screen.

In the Setup Assistant screen, look for your printer's mDNS service name (which you noted in step 1) in the
Printer Name column.

e [fyou find the right name, scroll sideways if necessary to see the Connection Type column, and check
that it shows Bonjour. Then highlight that line. Otherwise, continue searching further down the list.

e If you cannot find your printer's name just click Continue and do the setup manually in your System
Preferences later on.

Click Continue.

Continue following the instructions on the screen.

Uninstall the printer software (Mac 0S X)

During the previous installation step, you have the option to install the HP Uninstaller application in your system.
This should be available under HP in the system Applications folder.

M IMPORTANT:  The HP Uninstaller application will uninstall all HP Software installed in your system.

To delete the print queue only, select the Print & Scan dialog from the system preferences. Click the name of the
printer and then click the — button.

Configure your connectivity

By configuring your connectivity, you can print from your local network, keep your printer up to date, and access
additional printer services. Remember to connect your network cable to the printer.

Accept the connectivity agreement and settings in order to:

Receive automatic firmware updates
Participate in the Customer Involvement Program
Enable additional printer services

Enable email printing

A network connection is required, so the printer will test its own connectivity. Configure and troubleshoot the
printer’s connectivity and start benefitting from connecting your printer.

If you are part of the HP Partner Link Pay-per-use service, remember to go to the Connectivity app and tap
Printer services > Register new service in order to register the printer service.

Chapter 1
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During initial printer setup, you are asked whether you want to enable these services. That decision can be reset

later by tapping @ , then Connectivity > Reset Connectivity Agreement.

In addition, each service can be enabled or disabled individually as explained below.

Verify printer connection to HP

v >
You can check that the printer is able to connect to HP services by tapping ‘&’ , then @, and verifying the

status there.

Default Network Interface

0 Status

Automatically detect proxy settings: (on/off)

Automatic configuration script: (offf url of script ie hitp:/autocache hp.com)
[ If automatically detect proxy is off: |

Manual proxy setup: on/off

Proxy address

Proxy port

Proxy authentication: on/aff

If there is any problem connecting to HP. you will be provided with a description of the problem and some
possible solutions.

Configure the Customer Involvement Program and other printer services

You can check your Customer Involvement Program status by tapping ({.

Tap Test all connectivity to test your connection to HP, the Customer Involvement Program, and other online print

services. If any problem is detected, you will be provided with a description of the problem and some possible
solutions.

Configure email printing through HP Connected
The HP Connected service makes it easy to send jobs to your printer by attaching them to an email message.
You must accept the “Connectivity agreement” in order to use HP Connected. You can change your decision by

tapping E:é} , then Connectivity > Reset Connectivity Agreement.

To configure the email printing configuration, tap ({ € &, which will display your printer’s unique

printer code and the email address that can be used to send jobs to the printer. You must also visit
http://www.hpconnected.com to register yourself and your printer (using the printer code).

ENWW Preparing your printer
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Tap o in the top right corner of the HP Connected screen to access the following options:

e  HP Connected Connectivity menu: You can enable or disable HP Connected for this printer, or completely
remove it from the HP Connected service.

e  Printer code: You can view or renew the printer code.
e  Email address: You can view the printer's email address.

e  HP Connected jobs: You can decide whether jobs received by email should be printed directly (the default
option) or put on hold in the job queue.

e  Restore HP Connected settings: You can restore HP Connected settings to their default values.

Configure firmware updates

You can choose from the Embedded Web Server or from the front panel whether and how to download firmware
updates.

[%’/r NOTE: If an administrator password has been set, it will be required to change these settings.

e Inthe Embedded Web Server: click Setup > Firmware update.

e  Using the front panel: tap ,then [, then 3.

The following settings are available:

e  (Check: If you select Automatically (the default setting), the printer will check automatically every week (or
after the printer has been restarted seven times, whichever happens first) whether new firmware is
available. If you select Manually, the printer will not check automatically; you can check manually whenever
you like.

e  Download: If you select Automatically (the default setting), the printer will automatically download new
firmware whenever it becomes available. If you select Manually, you will be asked to approve each
download.

[%r NOTE: Downloading the firmware does not mean that you have installed it in your printer. To install the
new firmware, you must confirm the installation manually.

e  Firmware update history: A list of firmware versions that have been installed in the printer. It is usually
possible to reinstall the version immediately before the version that is currently installed, if you have some
problem with the current version.

Configure a scan-to-network or scan-to-FTP folder (MFP only)

A scanned image may be saved in a USB flash drive, in a network folder, or in an FTP folder. The USB flash drive
option requires no preparation, but the other options will not work until they have been set up in the following
way.

[%?9 NOTE: The printer accesses scan-to-network shared folders (as a client) using NTLMv1- and NHLMv2-based
authentication. Scan-to-FTP folder uses plain text authentication. Therefore scan-to-network should be
preferred for security reasons.
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Server configuration for scan-to-network folder

1. Create afolder on a computer that the scanner can access through the network. See Example: Create a
scan-to-network folder under Windows on page 22 or Example: Create a scan-to-network folder under

Mac OS on page 24.

2. Create a user account on the same computer for the printer.

3. (Change the sharing options of the folder so that it is shared with the 'scanner user’, and assign full control
of the folder to that user.

4.  Create a share name for the folder.

Server configuration for scan-to-FTP folder
1.  Create afolder onan FTP server.

2. Ensure that you know the server name, user name, and password for the FTP server.

[Q IMPORTANT:  You must complete the above steps for one option or the other before starting the
remaining steps below.

Configuration in the Embedded Web Server

1. Inthe printer's Embedded Web Server, click the Setup tab and then Scan to network. See Embedded Web
Server on page 13.
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Alternatively, in the HP Utility, click the Settings tab and then Scan to network. See HP Utility on page 12.

2. Onthe Scan to Network page, click Add network folder, and fill in the various fields.
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e  Protocol may be FTP or CIFS (scan-to-network).

e  Folder type may be public or private. The folder type is displayed in both the Embedded Web Server
and the front panel with anicon. When you select a private folder, you must enter a password in the
front panel.

e  Aliasis displayed in the front panel when you are choosing the scan destination. It may be different
from the network or FTP folder name.
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e  Set this network destination as a default. If you have installed HP SmartStream, the option to set it as
a destination appears.

e  Server name should contain the network name of the remote computer.
e  Folder name should contain the share name of the folder.

e  User name should contain the name of the 'scanner user'.

e  User password should contain the password of the 'scanner user'.

° Domain name should contain the name of the domain in which the user name exists. If the 'scanner
user' does not belong to any domain, leave this field empty.

The server and folder names are used to connect to the shared folder by building a network folder path as
follows: \\server name\folder name

For a network folder, enter the name or IP address of the remote computer, the name of the shared folder,
and the user name and password of the 'scanner user' that you have already created on the remote
computer. Leave the user domain field empty unless the user is a member of a Windows domain. If the
user is only a local user of the remote computer, leave the field empty. You can use the name (instead of
the IP address) in the server name field only if the shared folder is on a Windows computer in the same
local network.

For an FTP folder, enter the server name, folder name, user name, and password. Leave the user domain
empty.

3. Click Add to save the configuration.

[%f NOTE: If the product has already been configured for scanning to the network and you now want to use a
different shared folder, click Modify.

4.  The printer automatically checks that it can access the network folder. If not, see Cannot access the
network folder or HP SmartStream (if installed as an accessory) on page 129.

You can check at any later time that the shared folder remains accessible by clicking Verify in the Embedded
Web Server. A correctly configured shared folder can become inaccessible if the user’s password is
changed, or if the shared folder is moved or deleted.

Example: Create a scan-to-network folder under Windows

1. Create a new user account for the 'scanner user' on the remote computer. You can use an existing user
account for this purpose, but it is not recommended.

2. Create a new folder on the remote computer, unless you want to use an existing folder.

3. Right-click the folder and click Properties.
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4.  Inthe Sharing tab, click the Advanced Sharing button.

|, My Scans Fropertie_sk_ u

‘Generat‘ Sharing |Se:unty| Previous Versions Customlze‘

Netwark File and Folder Sharing

My Scans
l ) Not Shared

Netwark Path
Not Shared

Advanced Sharing

l Set custom permissions, create multiple shares, and set other
advanced sharing options

[ @ananceasnams. |

5. Check the Share this folder box.

Advanced Sharing u

|V]iShare this folder!

Settings
Share
My Scans
Add Remove

Limit the number of simultaneous users to:

I
Comments:
[ oK H Cancel H Apply l

You need to ensure that the 'scanner user' has full read/write control over the shared folder. To do this, click
Permissions and grant Full Control to the user (or to any suitable group that includes that user).

| . Permissions for My Scans. &
Share Permissions

Group or user names:

[ Add. [ Remoe |

Permissions for Everyone

Allow Deny
Full Control [
Change ]
Read B
Learn about access control and p: 1
oK | I Cancel ] I Apply
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7. Ifthereis a Security tab in the Properties window for your folder, then you must also grant the same user
Full Control over the folder in the Security tab. Only some file systems such as NTFS require this.

-
My Scans Properties @

General | Sharmgl Security ‘Prewous Versions Custom\zel

Object name: CAMy Scans

Group or user names:
£2 Authenticated Users
82, SYSTEM

To change permissions, click Edit

Permissions for Authenticated
Users Allow Deny

Full control v il
Modify

Read & execute 3
List folder contents

Read N
Write v

For special permissions or advanced settings.
click Advanced =

Leam about access control and permissions

LLLLs

[ ok ][ cancel ][ appy

The 'scanner user' can now access the folder and write files to it. Next, you must configure the printer to
send scans to the folder.

Example: Create a scan-to-network folder under Mac OS

1. Create a new user account for the 'scanner user' on the remote computer. You can use an existing user
account for this purpose, but it is not recommended.

2. Create or choose a folder on the remote computer. By default, Mac OS users have a Public folder that can
easily be used for this purpose.

3. Open the System Preferences application and click the Sharing icon.

800 Sharing

(o) (rama ] CE—

Computer Name: Joe Blogg's iMac

Computers on your local network can access your computer at: Joe-  (pai )
Bloggs-iMac.local \ .

On |Service ) File Sharing: Off

[ DVD or CD Sharing File Sharing allows other users to access shared folders on this computer
[ Screen Sharing and allows administrators to access all volumes.

1 Printer Sharing Shared Folders: Users:

[T Web Sharing (Z_1Joe Blogg's Public Folder A Joe Blogg Read & Write &
[ Remote Login 24 Users Read Only
[ Remote Management 4l Everyone Read Only
[T Remote Apple Events

[T Xarid Sharing

[T Internet Sharing

=

Bluetooth Sharing

+ = + ( Options... )

i
i ﬂ Click the lock to prevent further changes. @

4.  Make sure the 'scanner user' has Read & Write access to the folder.

5. Click Options.
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6.  Check the Share files and folder using SMB box, and make sure that the 'scanner user'is checked in the On
column.

("I Share files and folders using AFP
File Sharing: Off
I Share files and folders using FTP
‘Warning: FTP logins and data transfers are not encrypted.

E‘Share files and folders using SMB

When you enable SMB sharing for a user account, you must enter
the password for that account. Sharing with SMB stores this
password in a less secure manner.

On | Account

7. Click Done. You will now see file sharing enabled and Windows sharing on.

Internet Sharing
Bluetooth Sharing

800 Sharing
Show Al Q )
Computer Name: Joe Blogg's iMac
Computers on your local network can access your computer at: Joe- (Eai )
Bloggs-iMac.local e
On  Service @ Windows Sharing: On
] DVD or CD Sharing Windows Users can access your computer at smb://10.0.1.40.
1 Screen Sharing
E File Sharing
1 Printer Sharing Shared Folders: Users:
1 web Sharing [1Joe Blogg's Public Folder A Joe Blogg Read & Write %
1 Remote Login 2% Users Read Only
T Remote Management mEvewune Read Only
1 Remote Apple Events
1 Xgrid Sharing
M
=

+ | = + Options...

1
j { Click the lock to prevent further changes.

The 'scanner user' can now access the folder and write files to it. Next, you must configure the printer to
send scans to the folder.

Configure the email server

To configure the email server using the Embedded Web Server, click Setup > E-mail server, and fill in the
following fields, which are usually supplied by the email server provider.

e  SMTP server and port number: The IP address or fully qualified domain name of the outgoing mail server
(SMTP) that will process all email messages from the printer. If the mail server requires authentication,
email notifications will not work.

e  Printer e-mail address: The email address assigned to the account that is being configured in the printer.
This email address will appear in the From: field of all the email messages sent by the printer. This is not
the same email address that is used by HP Connected.

e  Attachment size limit: The maximum size of a file attached to an email message. When you scan to email
from the front panel, you will be warned if an attachment is higher than this limit, but you can ignore the
warning and send the message anyway.
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e  Use SSL certificates: Check this box to use SSL certificates if the server requires an encrypted connection.
Click the link to configure advanced certificate settings.

e  Authentication. If you choose authentication, you are also asked for your username and password.

Once you have configured the email server, you are strongly recommended to check the configuration.

Configure the email address book (MFP only)

The printer uses LDAP v3, the latest version of the Lightweight Directory Access Protocol (LDAP), which provides
access to a network address book for scan-to-email purposes.

To use LDAP, you need a printer firmware release dated January 2016 or later.

The following instructions explain how to use LDAP to connect the printer to a network email address book, and
how to configure a default SMTP to send email messages from the printer.

Email lookup

When the printer uses LDAP for scan-to-email, it searches a database of email addresses. When you enter the
email address and click the Search button, LDAP searches a list of email addresses for matching characters. You
can refine the search results by typing additional characters and performing a new search.

Printers that support LDAP also support the use of a standard outgoing email profile, so they do not require a
connection to an LDAP server in order to send email.

Information needed before starting

Ensure that you have the following information before starting the configuration:
[ Server authentication requirements
e  Pathto start search (BaseDN, Search Root) (for example, o=mycompany.com)

e  Attributes for matching the name entered (such as cn or samAccountName), retrieving the email address
(such as mail), and how the name will be displayed on the control panel (such as displayName)

Address book setup

26

In the Embedded Web Server, click Setup > Address book to access the network address book.

From here you can configure the printer to obtain email addresses from an LDAP server, so that they are
available when users perform a search from the Scan to Email screen.

1. Open the Embedded Web Server.
2. Click the Setup tab.

3. Inthe left navigation pane, click Address book.
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Click Enable network contacts (use LDAP server).

O v s glalglale
IO \o ~

Setup

Configuration
Printer settings

Security

HP Connected connectivity

E-mail server

Address Book

Notification

Scan to network

Date & Time

Anonymous usage information storage
Maintenance

Firmveare update

Paper management

Logged in as administrator

Address Book =

Network Contacts Setup

Enable Network Contacts (use LDAP server)

Click Add button to configure a server.

Contacts Stored on the Device

Enable store contacts

Click the Add button to proceed to the LDAP configuration page.

O 11
IQ \0

Setup

Configuration
Frinter settings

Security

HP Connected connectivity

E-mail server

Address Book

Notification

Scan to network

Date & Time

Anonymous usage information storage
Maintenance

Firmweare update

Faper management

Logged in as administrator

| Customer involvement Program |

Address Book =

Network Directory Server (LDAP)

o s [

[ use a secure connnection (SSL}

Server Authentication Requirements

(@) Server does not require authentication
(7) Server requires authentication

LDAP Database Search Settings

Path to start search (BaseDN, Search Root)

L ]

Recipient's Display Name: Recipient's E-mail Address:

|displayhame | [mai

LDAP Fitter Condition:

Test for LDAP Retrieval

Test

In the LDAP server address box, enter the name of the LDAP server (for example,
ldap.mycompany.com).

If you do not know the LDAP server, contact the server administrator and obtain the network address and
the attribute codes to use.

To enable a secure (SSL) connection, click Use a secure connection (SSL).

If the LDAP server requires authentication, select the appropriate authentication type in the Server
Authentication Requirements area.

In the Path to start search (BaseDN, Search Root) box, enter the path to start searching the database (for
example, o=mycompany . com).
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10. Inthe Recipients's display name box, enter the name of the attribute that contains the person's name (for
example, displayName).

11. In the Recipient's email address box, enter the name of the attribute that contains the person's email
address (for example, mail or rfc822Mailbox).

12. Use the LDAP filter condition box to set up an optional filter to filter out e-mail addresses.

13. To check that the LDAP retrieval is set up correctly, enter at least three characters of a network contact
name in the Test box, and then click the Test button. If the test is successful, a list of possible matches is
displayed.

14. Click the Apply button to save the settings. Setup is complete.

Turn usage information on and off
The printer can send usage information periodically by email. You can request this in the following ways:
e Inthe HP DesignJet Utility for Windows: from the Admin tab, click Printer settings > Accounting.
e Inthe HP Utility for Mac OS X: click Printer Settings > Accounting.
e  Inthe Embedded Web Server: click Setup > Printer settings > Accounting.
In each case, you must set the following options:
e  Send accounting files: Enabled (the default is Disabled)
e  Send accounting files to: a valid email address
e  Send accounting files every: choose a number of days (1-60) or a number of prints (1-500)

You must also ensure that the email server has been configured: see Configure the email server on page 25.

Turn email notifications on and off

In order to receive email notifications from the printer, you must have configured the email server (see Configure
the email server on page 25).

The notification service is always turned on, but all specific notifications are turned off by default. You can turn
them on or off individually by selecting Notifications from the Setup tab of the Embedded Web Server.

Control access to the printer

Front-panel security settings

From the front panel, you can tap @ , then Security, to control some of the features of the printer:

e  USBdrive: Enable or disable the use of a USB flash drive.
e  Firmware update from USB: Enable or disable firmware updates from a USB flash drive.

e  Enable HP Connected Center connectivity.
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User sessions: Enable or disable automatic log-out after 1, 3, or 5 minutes.
EWS: Enable or disable the Embedded Web Server.
Printer access control: Enable, disable, or change the administrator password.

Printing & management Web services: Enable or disable Web services that are used by printing and
management tools such as the HP Utility, HP SmartStream, and SDK for RIPs.

Scan remote-control Web service (MFP only): Enable or disable Web services that are used to control the
server remotely.

If an administrator password has been set, it must be given in order to perform the following operations:

Change the security settings (including the administrator password itself)

Change the configuration of the Internet connection

Change the Automatic Firmware Update configuration

Enable or disable automatic downloading and/or installation of automatic firmware updates
Restare an earlier firmware version

Reset factory defaults

[:?’”r NOTE: The administrator password can contain only characters that appear on the front panel's on-screen
keyboard. If you set a new password with the Embedded Web Server, it will reject characters that do not appear
in that limited character set.

Embedded Web Server security settings

From the Embedded Web Server, you can click the Setup tab and then Security to change the security settings:

Specify separate administrator and guest passwords to control access to the Embedded Web Server
Securely erase some or all files on the hard disk
Enable or disable various groups of front panel operations

Use the same security settings that are available in the front panel (see above)

B’ NOTE:  An administrator password may be required.

ﬂ% NOTE: For more information, see the Embedded Web Server's online help.

To control access to the printer’s front panel from the Embedded Web Server, go the Setup tab, and click Security.
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7]
e [ BN botworking | Customerimvohvement Program | supori |
Security [~

Printer status: 3 Load paper for next job £

* Accass control To ensble i you must set the

Mass Storage

[ Omable USB drives
[[1  Daable trmware update from USE

Seiect an option to Set the keve of the contre panci access ook

Unlock
Mmimam Lack
Moderate Lock
dermediste Lock
Maximum Lock

Select an option to Set e fie erase mode.

ton-Secure Mode
Securs Fast Erase (1-pass)
Secure Santizing Erase (S-pass}

Wote. * Charging the fils erase moce can cause pe rlormance issues,

The following options are available:

e  Unlock: Unrestricted access to the front panel.
e  Minimum Lock: Unrestricted access to the front panel.

e  Moderate Lock: In addition to the Minimum Lock, denies access to all printer settings, the job queue,
information and service prints, and the printer log.

e Intermediate Lock: In addition to the Moderate Lock, denies access to the paper, ink supplies, maintenance
options, and demo prints. Users can only view printer and supply information.

e  Maximum Lock: Denies access to all front-panel options. No detailed information is displayed in any of the
status applications.

When any option is restricted, the option is locked and marked with a padlock icon.

Embedded Web Server access control

From the Embedded Web Server, you can click the Setup tab and then Access control to change the access
control settings.

To use these access control settings, the security settings should permit unrestricted access to the front panel
(Unlock). See Embedded Web Server security settings on page 29.

Access control categories

e  Sign-in methods: Manage the methods that can be used to sign in to the printer.
e  Device user accounts: Create, edit, or delete printer user accounts.

e Sign-in and permission policies: Manage sign-in requirements for specific tasks, restricting user access by
type of activity.
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Sign-in methods

Currently, the only available sign-in method is Local device, referring to local accounts that have access codes
between 4 and 8 digits long, stored on the printer’s hard disk.

Sign-in methods.

Enabled sign-in methods can be used to sign in at the device.

[ status | sign-in method [r——
| on Local device Local accounts have access codes between 4 and 8 digils long. Accounts are stored on product hard disk. |

Device user accounts

There are four available actions:

e  New: Add a new user account.

e  Edit: Edit the selected user account.

o  Delete: Delete the selected user account.
e  Deleteall: Delete all user accounts.

When using device user accounts, people will sign in at the device using an access code. A permission set is assigned to each account.

When you click New, the following window opens, in which you must fill in at least the name and the email
address.

New device user account

Name [30nn Email [iohn@doe.com ]
User aceess code (48399908 | Metwork user name (fully qualified) | ]

Permission set | Device user | &

| Apoty [ Cancel |
You can change the user access code, and the permission set, as follows:

e  Adminuser: The admin user has all access privileges granted and cannot be edited.

e  Device user: The device user has some access privileges granted, which can be edited on the access control
page.

e  (Guest user: The guest user has some access privileges granted, which can be edited on the access control

page.
Click Apply to add the new user, who is then displayed as shown below.

Device user accounts

When using devics user accounts, people will sign in atths devics using an access code. A permission sst is assigned to each account

| ] John john@doe com 48399908 - Device user |

Sign-in and permissions policies

You can change the permissions for device and guest users here, and click Apply to apply them.
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Configuration
Printer settings
security

Access Control

HP ePrint connectivity
Email server

Address Book
Notification

Scan lo network

Dats & Time

Anenymous usage information
storage

Maintenance
Firmware update

Paper management

[ etworking ] Gustomer ivobvement Program | Support ]
Access Control [ 2|

Enabled sign-in methods can be used tosign in at the device

[ status | sign-in method

| on Local device Local accounts have access codes between 4 and 8 digits long. Accounts are stored on product hard disk. |

When using device user accounts, pecple will sign in atthe device using an access code. A permission sel is assigned to each account.

[ [ veme L cmni L uneaceess cose | Networ unername by L perminonsel

You can set sign-in requirements for speciic tasks, and restrict access by users who have not signed in ("Guests’) to specific features. Permissions can be applied to local user accounts stored on the printer

I - S [ S
& Administration
Fimmware update ‘ (=]
setogs . =
Miew network status. ’ (=]
Modty network configuration - 1]
Qplimize printing guality . =
Prepare printer for reshipment v =]
Restore factory setings v =]
copy - =]
o Pant v =]
Prnt in color v =)
Erint from USB v =
& ik v [~
Manage ink System (Setngs) = M
& Paper v M
Paper soulce setlings @ =]
& Sean v (=]
Scan to emai ‘ =
Scan to Aetwork folder =)
Save to USB dive - =]
) Job queue ‘ =]
Manage job queue = =]
[ Appiy | Access Grantea [7] Requre Sgnin  [7] Full Access [ ] Access Deniea

@f NOTE: To use some functions, you must be able to use the higher-level function: for example, Print from USB
requires Print.

ﬁ/‘ NOTE: All users have at least guest permissions.

[%/ NOTE: The Firmware Update function means, in this context, automatic firmware updates. To block firmware
updates from a USB flash drive, you must use a specific setting that affects all users.

When a user tries to use any blocked function for the first time, the following window appears, in which the user
should give the appropriate password. To give the admin password, click the three dots in the upper right corner.

Printer authentication

Enter password to unlock this option

User password

Cancel ‘ 0K
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Require account ID

Drivers

If you want to keep records of printer usage by different user accounts, you can set your printer to require an
account ID for each job.

e Inthe HP DesignJet Utility for Windows: from the Admin tab, click Printer settings > Accounting > Require
account ID.

e Inthe HP Utility for Mac OS X: click Printer Settings > Accounting > Require account ID.

If this setting is turned on, the account ID field will be mandatory and jobs with no account ID will be kept "on hold
for accounting".

The account ID can be set in the printer driver when sending the jab. If the job is set "on hold for accounting” by
the printer, you can introduce the account ID in the Embedded Web Server, HP DesignJet Utility, HP Utility, or front
panel, by going to the job queue and clicking the job that is on hold. A window with a text box is displayed and
you can enter the account ID into it.

There are various different drivers for your printer; which is best for you depends on your circumstances:
e  Your operating system

e The type of applications from which you print

e  The number of printers you have

e  The output accessories you have

You may wish to install one or several drivers according to your needs.

You can find the latest driver software at http://www.hp.com/go/pagewidex|series/support/drivers/.

Specific Windows drivers

HP-GL/2 PCL3GUI v4 PostScript PostScript v4 PDF v4

CAD, GIS, office
applications
Applications requiring

Recommended | Recommended

Application Recommended | Recommended
accurate color
Adobe Acrobat or Recommended
Adobe InDesign
Windows 8 or later
System

Desktop

Modern P -:-

ENWW
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Universal Windows driver

The Universal Windows driver is recommended if you have a fleet of HP DesignJet and PageWide XL printers: it
facilitates installation and queue management. The driver includes HP-GL/2 and PostScript options.

Universal Windows driver configuration tool

The Universal Windows driver configuration tool is a utility to create VDF files, with which you can personalize
DesignJet and PageWide XL Universal Printer Drivers (UPDs) by modifying the default settings or locking some of
them, preventing users from changing them. This tool is intended for IT administrators, allowing them to set or
lock the color, rotation, and quality options of the driver for different user roles.

Toinstall the tool, go to http://www.hp.com/go/pagewidexlseries/support/. If prompted, select your printer from
the list.

In the Software and Drivers section, click Software > Utility > UPD configuration tool > Download. For information
about how to install and use it, go to https://support.hp.com/us-en/document/c05658213.

Mac OS drivers

Raster driver
e  Specifically for Mac 0S X 10.8, 10.9,and 10.10

e  Best for CAD, GIS, and office applications

PostScript 3 driver
° Specifically for Mac 0S X 10.8, 10.9, and 10.10

e  Best for applications requiring accurate color

In addition to http://www.hp.com/go/pagewidexlseries/support/drivers/, Mac OS drivers are available through
Apple Software update.

Set Windows driver preferences

You can change some default settings in your printer driver according to your own preferences, for instance to
set color emulation or paper-saving options. To do this, click the Start button on your computer's screen, then
click Devices and Settings. In the Devices and Settings window, right-click your printer's icon, and click Printing
Preferences. Any settings you change in the Printing Preferences window will be saved as default values for the
current user.

To set the default values for all users of your system, right-click the printer’s icon, click Printer Properties, go to
the Advanced tab, and click Printing Defaults. Any settings you change in the printing defaults will be saved for all
users.
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Accessibility

Front panel

If required, the front-panel display brightness and the loudspeaker volume can be changed (see Change system
options on page 11).

Embedded Web Server

From the Embedded Web Server, you can see the status of the printer, and perform other actions without using
the front panel.

For information about the accessibility features of the Embedded Web Server, go to: Support > Browse
information > Accessibility:

Accessibility Features
Cioge window

MNote: if you are using a sereen reader, you may wish to turn off the periodic printer status updates. You can do this by changing the Refresh rate option on the Printer settings page to "o refresh’.

This site comglies with main Web Content Accessibiity Guidelines. A text equivalent i provided for every non-lext element, Form controls are properly grouped and labelied. Row and column hesders in data tables are identified and associated with the comesponding table
celis, Important user interface items have shortcut keys to enable quick access, shown below:

List of area access keys List of buttons access keys
Access Key

Any button sending data to the printer (Frint, Apply, Update....}
Cancel button, revert form changes
| Generic help Get support page

GO to main tabs ares
Go toleft menu items area |Mda!u

oxxm

| Supples ordering Order supplies to HP

‘AccessKey Combination for buttons access keys
ALT = AccessKey

Internet Explorer 7 and above ALT + AccessKey, TAB lo activate first item in the area
Nozila Firefax 3.6 and above ALT + AccessKey, TAB o activate first tem in the area ALT + Accesskey
Goagle Chrome 7 and above ALT + AccessKey, TAB to activate first tem in the area ALT + Accesskey
Safari 3 and above ALT + AccessKey, TAB to activate first item in the area ALT + AccessKey

See more about HP accessibility at www.hp.com/hpinfo/abouthp/accessibility/ for information about the HP
Accessibility Program, and HP's commitment to making its products and services accessible to people with

disabilities.

Other sources of information

The following documents can be downloaded from http://www.hp.com/go/pagewidexlseries/support/manuals/:

° Introductory information
e  User's guide

e Legalinformation

e  Limited warranty

The Quick Response (QR) code images found in some parts of this guide provide links to additional video
explanations of particular topics.
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2  Paper handling

e  (Generalinformation and tips

e  Supported paper types

e  Paper status
e | oadpaper

e  Unload paper
e  Paper options

° Store paper

e  (annot load paper

° Protect a paper type

° Paper jam
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General information and tips

ENWW

All paper widths must be between 279 mm (11 in) and 1016 mm (40 in), and the roll core must be 76 mm
(3in) in diameter.

When handling photo paper, wear cotton gloves to avoid transferring oils onto the paper.
Each drawer can be loaded with two paper rolls (front and rear).

Your printer has one or two drawers: the second may be purchased as an accessory. The roll positions are
numbered 1 and 2 in the top drawer, 3 and 4 in the bottom drawer.

] ]

§ { ] —) ¢ { ] —)
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The roll numbers are displayed on the front of each drawer and on the roll hubs.

Each drawer has lights to communicate its status:

Drawer roll icon light

—  Off: Theroll has paper, or there is no roll.

—  On(yellow): The roll is running out of paper.

General information and tips
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—  On(red): The rollis out of paper.

Drawer lock light
- ﬂ Off: You can open the drawer.
- ﬂ On: Do not open the drawer. The paper is moving and you could cause a paper jam.

e  You can save paper by using the appropriate settings.

e  The printer automatically estimates the remaining length of the roll.

Supported paper types

The following paper types are compatible with your printer.

Supported HP papers

Name Width Length Product number

Plain paper

HP Universal Bond Paper, 3-in core 16.5in (420 mm) 500 ft (152 m) K6B85A
18in (457 mm) 500 ft (152 m) M2NO4A
23.4in (594 mm) 500 ft (152 m) K6B86A
24in (670 mm) 500 ft (152 m) K6B88A
30in (762 mm) 500 ft (152 m) M2NO5A
33.1in (841 mm) 500 ft (152 m) KeB87A
36in (914 mm) 500 ft (152 m) L4L08A
36in (914 mm) 575ft (175 m) M2NO6A

HP Bright White Inkjet Paper, 3-in core 16.5in (420 mm) 500 ft (152 m) L4Z41A
23.41in (594 mm) 500 ft (152 m) L4z42A
24in (610 mm) 500 ft (152 m) L4z44A
33.71in (841 mm) 500 ft (152 m) L4743A
36in (974 mm) 500 ft (152 m) L4745A

HP Premium Bond Paper, 3-in core 24in (610 mm) 300 ft (91 m) L6B12A
33.1in (841 mm) 300t (91 m) L6B11A
36in (914 mm) 300t (91 m) L6B13A
40in (1016 mm) 300 ft (91 m) L6B14A

Coated paper
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Name Width Length Product number

HP Universal Heavyweight Coated Paper, 3-in core 33.1in (841 mm) 300t (31 m) L5C79A
36in (914 mm) 300t (91 m) L5C80A
40in (1016 mm) 300t (91 m) L5C81A

Poster paper

HP Production Matte Poster Paper, 3-in core 24in (610 mm) 150 ft (46 m) N2V71A
24in (610 mm) 300 ft (91 m) L5P96A
36in (914 mm) 150 ft (46 m) N2V72A
36in (914 mm) 300 ft (91 m) L5P97A
40in (1016 mm) 150 ft (46 m) N2V73A
40in (1016 mm) 300 ft (91 m) L5P98A

HP Production Satin Poster Paper, 3-in core 24in (610 mm) 150 ft (46 m) N2V75A
24in (610 mm) 300 ft (91 m) L5Q071A
36in (914 mm) 150 ft (46 m) N2V76A
36in (914 mm) 300t (91 m) L5Q02A
40in (1016 mm) 150 ft (46 m) N2V77A
40in (1016 mm) 300t (91 m) L5Q03A

HP Gloss Poster Paper, 3-in core 40in (1016 mm) 200 ft (61 m) L5Q08A

Banner

HP Matte Polypropylene, 3-in core 40in (1016 mm) 150 ft (46 m) L6B19A

Other supported paper types
Plain papers
e  Plain paper < 90 g/m?
e  Plain paper 90-110 g/m?
e  Plain paper > 110 g/m?
e  Recycled

e  C(Colored paper

Technical papers
e Vellum

e  Translucent bond paper

Coated papers
e  (oated paper 90-100 g/m?

e  Heavyweight coated paper

ENWW
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40

Poster papers

e  Poster matte paper

° Poster satin paper

e  Poster gloss paper

e  Photo semi-gloss paper

e  Blue-back paper

Banner and sign
e  Polypropylene

e  Tyvek 135 g/mz

Blueprint

e  Blueprint

Paper status

The paper source displays the drawers in your printer, and one of the following status messages for each roll:

° Low on paper

e  Qut of paper

e  Paper not loaded

e  (alibration pending

e (heck pending

e  Unsuccessfully loaded
e  load malfunction

e  Ready

° Error

Load paper

1. Start the paper app to access the paper menu, then tap Load.

% TIP: Ifthe printer is not printing and the lock light on the drawer is off, you can skip this step.
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2. Open the drawer.

"\

AWARNING! Do not stand on the drawer: the printer could fall over.
A CAUTION:  MFP only: Do not leave the roll on top of the scanner.
% TIP:  You can load more than one roll at the same time.

TIP:  Load heavier rolls in upper drawers; they can weigh up to 18 kg (40 b).

3. Open the locking levers on the left and right hubs.

4,
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5. Place therollinto the drawer between the hubs, with the paper edge as shown.

7. Ensure that the hubs are fitted tightly to the roll on both sides.
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8. Important: Close the locking levers on the left and right hubs.

9.

X TIP: The rear roll may need extra roll-ups to facilitate automatic feeding. Do not stop feeding until the
paper is automatically advanced.

10. Continue feeding until you hear a beep.

11. If the paper edge is not straight and clean, you can cut it off with the appropriate button (there is a button
for each roll in the drawer).

When you press the button, the paper is advanced; when you release the button, the paper is cut.

Remember to remove the cut strip of paper.

12. Close the drawer when you have finished loading rolls into it.

ENWW Load paper
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13. Select the paper type on the front panel. The front panel remembers the last paper type loaded in this
position, in case that helps.

Paper load: Paper type selection O
Roll 1 Roll 2
Ready Ready
Roll3 Roll 4
Ready Check pending
24 Width: 24"

Roll 5

Roll 6
Check pending Ready
Width: 24" 20"
Load ancther Finish & check

Roll1. Paper type

Recently used ~
Plain Paper 90 gsm
Plain Paper 120 gsm
Bond Paper 110 gsm
Bond & Coated paper N
Photo paper A

14. When you are ready, tap Finish and check. The printer checks the position, width, and length of the loaded
paper. The width and length are displayed on the main screen.

[i?? NOTE: If you do not select a paper type, the front panel waits a while and then executes Finish and check
automatically.

Unload paper
1. Ensure that the printer is not printing and that the lock light on the drawer is off.

2. Open the drawer.

"‘"\

AWARNING! Do not stand on the drawer: the printer could fall over.

3. Remove the paper from the feeding slot.

4.  Open the locking levers on the left and right hubs.
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5. Slide the hubs to the side so that you can remove the roll.
Remove the roll (or the core, if only the core is left).

Close the locking levers on the left and right hubs.

© N o

Close the drawer.

Paper options

To see the paper options, tap o .

Paper source O
©® =

Roll1 Roll2

= Ready Ready
Plain Paper (<90gsm) Plain Paper (<30gsm)
Width: 24" Width: 24"

Roll 3

Ready
Heavy Weight Coated
Width: 24

Roll 5

Roll4
Check pending
Plain Paper (>110gsm)
Width: 24"

Roll6

Check pending Ready
HP Polypropilene HP Universal Bond Paper
Width: 24" width: 24"

The following options are available:
e  Edit type: You can modify the type of paper loaded.

e  Protect paper types: You can protect selected paper types to avoid printing on them unintentionally.

Store paper

To maintain paper quality, follow these recommendations:

e  Storerolls in the original packaging within the temperature and humidity range specified on the paper
label.

e  When natural tracing paper is stored in a humid environment, its width when loaded can vary, and it may
even jam in the printer. To avoid this, store this kind of paper in its packaging in humid conditions. Remove
it from the printer in conditions of low temperature and high humidity (such as 15°C and 80% relative
humidity). If you see that the paper has been affected by humidity, cut off the beginning of the roll: about 8
m (26 ft).

e  Store rolls covered by another piece of paper or cloth.

e  Allow all papers to adapt to room conditions, out of the packaging, for 24 hours before using them for
printing.
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e  The use of tape to stick the leading edge of the roll to the core is especially important for heavy papers,
because the inherent stiffness of the paper can cause it to loosen and unwind from the core.

[

AN

LLLieerp

LER R RN R

Cannot load paper

e  (heck that you have aroll in the selected drawer and slot.

e  (Check that the locking levers are closed on both hubs, and that the hubs are correctly positioned.
e  Ensure that you locked the hubs before feeding paper into the printer.

e  (Check that the paper is correctly fed into the printer.

e  (heck that the paper is not crumpled or warped, and that the edges are straight.

e  (Check that the drawer is correctly closed.

e  (heck that the paper is wound tightly on the roll.

e  (Check that the paper is attached to the core.

e  (heck that you follow the paper specifications.

X TIP: When loading rear rolls, you must feed more paper manually (@about 40 cm, or 16 in) than with front rolls.

Protect a paper type

You can protect selected paper types to avoid printing on them unintentionally. A protected paper type will be
printed on only when the paper type is explicitly specified in the job.

To protect a paper type, go to the paper app, tap ... for the paper type you want to protect, then Protect roll.
Alternatively, you can tap , then Job management > Automatic roll selection > Protected paper types.
When a paper type is protected, the i icon appears before the paper name.

To print on a protected roll, just select the paper type explicitly when submitting the job from a printer driver or
other job submission software.

[%’/r NOTE: If a protected paper type is not explicitly selected, and no other paper types are available, an out-of-
paper message will appear.
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Paper jam

When the printer detects a jam, it tries to resolve the issue automatically. If it cannot, it stops, and you must fix
the problem manually.

The front panel starts the paper jam wizard to display where the jam occurs and how to fix it.

Paper jam resolution center

Paper output

© Jam detected

Push button to elevate output module

Paper access front cover

Clear the paper jam as instructed on each screen of the wizard. When you have removed all the paper, tap Check
now to check that the problem has been fixed successfully.

Paper jam in a drawer

1. Open the drawer in which the paper jam has occurred.

O]
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2. Cut the paper if necessary.

3. Open the front cover of the drawer.

Areas where a jam may occur are identified with this label:

4. Move the cutter to the right-hand side, unless it is there already.

A CAUTION:  Take care not to cut yourself when moving the cutter.

CAUTION: Do not dismantle the cutter assembly: refer it to qualified service personnel for servicing.
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5. Remove the paper, cutting it manually if necessary.

7.  Close the front cover of the drawer.

8.  Rewind the paper.
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9.  Cutoff the leading edge of the paper if it has been damaged.

10. Rewind again and feed the paper into the slot.

11. Use the paper-cut button to cut the leading edge again.
12. Close the drawer.

13.  Wait until the printer is ready for paper.

14. The printer resumes the job and automatically reprints any lost pages. However, you should check that all
pages of the job have been printed.

Paper jam in the paper access front cover

1. Open the front cover.
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2. Pull out the paper.

3. Cutthe paper if necessary.

@ IMPORTANT:  Use scissors for this purpose, not a single blade.

4. Make sure there are no loose pieces of paper left.
5. Close the front cover.
6.  Wait until the printer is ready for paper.

7. The printer resumes the job and automatically reprints any lost pages. However, you should check that all
pages of the job have been printed.

Paper jam in the belts

o,

Pl
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1.  Locate the top-stacker cover.
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Open the top-stacker cover.

2.

Empty the top stacker.

3.

ENWW
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4.  Locate and pull the left handle to open the print-bar cover.

7.  Close the top-stacker cover.
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Paper jam in the top stacker
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1. Locate the top-stacker cover.

ENWW
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Open the top-stacker cover and remove the paper.

2.

Close the top-stacker cover.

3.
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4.  Locate the top-stacker rear cover.

5. Open the top-stacker rear cover and remove the paper.

6.  Close the top-stacker rear cover.
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7.  Check that there is no paper in the output zone. Be careful with the pinchwheels.

8.  Ensure that no pieces of paper are left in the printer.

Paper jam in the folder input (HP F60, HP F70, and HP PageWide XL folders)

2.
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3. Pull the paper to remove it from the printer. Be careful with the pinchwheels.

4.  Ensure that no pieces of paper are left in the printer.

5. Close the folder tray.

Paper jam in the no-fold tray (HP F60, HP F70, and HP PageWide XL folders)

-"'lﬁ:lln
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M IMPORTANT:  This operation must be performed by a service engineer or by someone else with appropriate
training.

1. Open the top cover of the tray.

2. Cutthe paper between the printer and the folder, if necessary.
3. Remove the paper.

4.  Close the cover.

A CAUTION:  Be careful where you place your hands.

5. Wait until the printer is ready for paper.

6.  The printer resumes the job and automatically reprints any lost pages. However, you should check that all
pages of the job have been printed.

Paper jam on the fan-folding path (HP F60, HP F70, and HP PageWide XL folders)

-"'lﬁ:lln

1. Trytoremove the paper by pulling it from the no-fold tray. If you cannot remove all the paper this way,
continue with the following steps.

2. Open the fan-folding cover.
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3. Pullthe paper out.

[:?’”f NOTE: You may see paper by the fan-fold tray or at the rear of the folder. Try to pull it out wherever you
seeit.

4.  Remove any remaining pieces of paper.
5. Ensure that the metal balls remain in place.
Close the cover.

Wait until the printer is ready for paper.

© N o

The printer resumes the job and automatically reprints any lost pages. However, you should check that all
pages of the job have been printed.

Paper jam between the fan fold and cross-folding path

This should be easily visible from behind the folder. Open the fan-fold cover to stop the folder motor, and remove
the paper.

Paper jam on the cross-folding path (HP F60, HP F70, and HP PageWide XL folders)

-"'lﬁ:lln

1.
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2. Remove the paper.

/\ CAUTION:  Take care to avoid injury.

3. Close the cover.
4. Wait until the printer is ready for paper.

5. The printer resumes the job and automatically reprints any lost pages. However, you should check that all
pages of the job have been printed.

Paper jam in the high-capacity stacker

1. Press the output button to raise the output module.

2. Remove the high-capacity stacker. You can pull the stacker by the beam at the rear of the tray.

3. Cutthe paper between the printer and the high-capacity stacker, if necessary.
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4.  Remove the paper from the high-capacity stacker.

5.

6.  Close the output module.

7. Reconnect the high-capacity stacker.
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8.  Wait until the printer is ready for paper.

9.  The printer resumes the job and automatically reprints any lost pages. However, you should check that all
pages of the job have been printed.

Paper jam in the scanner (MFP only)

1. Empty the top stacker.

2. Pull out the top stacker.

3. Thereis asmall lever at the rear left of the scanner. Slide the lever up and open the scanner cover.

-

s

4.  Remove the paper.

5. Make sure there is no paper left in the scanner (insert your hand).
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6. Close the cover.

7.  Close the top stacker.

8.  The printer resumes the job and automatically reprints any lost pages. However, you should check that all
pages of the job have been printed.
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Ink cartridges

The printer has a set of four ink cartridges in the order CKYM, with a capacity of 400 ml each.

C| K

Below each ink cartridge, the printer has two LED indicators: a padlock and an inkdrop.

CE‘ ﬂb ﬂd MHO

e Thepadlock LED is on when the cartridge is in use.

@ IMPORTANT: Do not try to remove a cartridge when the padlock LED is on.

e  Theinkdrop LED turns yellow when the cartridge is almost out of ink, and turns red when the cartridge is
empty or faulty.

Ink cartridges require no maintenance or cleaning, but must be shaken before installation. High-quality printing is
maintained even when the ink level is low.

A CAUTION:  Avoid touching pins, leads, and circuitry when handling ink cartridges, because these elements are
sensitive to electrostatic discharge. Such devices are called ESD-sensitive devices. See Glossary on page 182.
Electrostatic discharges are one of the main hazards to electronics products. This type of damage can reduce the
life expectancy of the device.

The status of each cartridge is reported in the front panel:

e  OK:The cartridge is working normally.

e  Reseat: The cartridge is not responding, but removing and reinserting it may solve the problem.

e  Replace: The cartridge has been identified as faulty. It should be replaced by a functional cartridge.
e Lowonink: The cartridge is low on ink. It should be replaced soon.

e Verylow onink: The cartridge is very low on ink. It should be replaced very soon.

e  Empty: The cartridge has no ink. It should be replaced.

e  Missing: The cartridge is missing.

e  Wrong/Incompatible/Incorrect: The cartridge type is not suitable for this printer.

e  Expired: The cartridge has reached its expiration date.

e  Altered: The cartridge has been identified as refilled or altered.
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Ink cartridge part numbers

Replace ink cartridges on the fly

Replace ink cartridges from the front panel

ENWW

PageWide Printer 400 ml

TXB40A HP 849 400-ml Black Ink Cartridge
TXB39A HP 849 400-ml Cyan Ink Cartridge
TXB37A HP 849 400-ml Magenta Ink Cartridge
T1XB38A HP 849 400-ml Yellow Ink Cartridge

You can replace a cartridge at any time when its padlock LED is off. If the padlock LED is on, you must pause the
job queue and wait until the LED turns off.

1.  Goto the front panel and tap @ , then the Ink cartridges tab, then Replace.

If a cartridge runs out of ink, the printer will automatically try to switch to the other cartridge of the same

color, after which you can replace the empty cartridge without any interruption to printing. If the ink

cartridge you want to replace is locked, you will need to pause the job queue to continue.

2. When prompted, press the old cartridge and slide it up to release it.

Ink cartridges
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3. Shake the new cartridge six times.

4,

5. Follow the instructions in the front panel.
6. When you have replaced all cartridges that you want to replace, tap Finish and check.

7. Make sure that you comply with all applicable federal, state, and local regulations when disposing of ink
system consumables.

If the available ink is exhausted while printing a page, printing stops and the page is ejected. When a new
cartridge is inserted, printing can resume, and the interrupted page is reprinted in full.

HP recommends that you replace an empty cartridge with a new HP cartridge. See Ink cartridge part numbers
on page 67.

The use of refilled or altered ink cartridges has several serious disadvantages:

e  Thereis some risk of damaging the printer. In this case the printer warranty will not be valid for any printer
repairs that are related to the cartridge, nor for any problems due to ink contamination.

e  You will invalidate the warranty of all printheads of the same color used in the printer subsequently.
e  Print quality may be impaired.

e  The printer will be unable to estimate the ink level in the cartridge, and will not report it.
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If you want to force the printer to accept what it sees as an empty cartridge, proceed as follows:

1. Tap @ on the front panel, then B . B4 . 4 - .

2. The front panel notifies you that the cartridge is altered, and the cartridge acceptance process starts.
Follow the instructions displayed on the front panel. If your cartridge is not an Original HP cartridge, HP
recommends that you stop the process. To check the authenticity of your cartridges, go to
http://www.hp.com/go/anticounterfeit.

3. If you proceed, the front panel displays a series of warning messages.

When the process is finished, the front panel gives the usual ink cartridge display, but the cartridge does not
report its ink level.

[%”f NOTE: Dynamic security enabled printer. Only intended to be used with cartridges using an HP original chip.
Cartridges using a non-HP chip may not work, and those that work today may not work in the future. More at:
http://www.hp.com/go/learnaboutsupplies.

Ink cartridge maintenance
During the normal lifetime of a cartridge, no specific maintenance is required. You should replace a cartridge

when it has reached its expiry date. You can find the expiry date in the the ink cartridge information on the front
panel.

Ink cartridge troubleshooting
1. Check that you have the correct type of cartridge (model number).
2. (Check that the cartridge label is the same color as the slot label.

3. Check that the cartridge is correctly oriented: the arrow on the front of the cartridge should face upwards.

A CAUTION:  Never clean inside the ink cartridge slots.

Print bar

The key printing element is a fixed 40 inch (1016 mm) print bar, composed of 8 printheads, numbered 1 to 8
from left to right, looking at the printer from the front. The paper advances at high speed underneath the print
bar, which ejects pigmented inks in four colors.
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The printheads are extremely durable and do not need to be replaced every time an ink cartridge is replaced.
They provide excellent results even when the ink cartridges contain a low level of ink.

To maintain optimum print quality, the printheads are automatically tested at regular intervals, and automatically
serviced when necessary. This takes a little time and can occasionally delay printing. When a printhead
eventually needs to be replaced, the front panel will display a message.

The printer’s paper-loading system includes an auto-indexing facility: whenever paper is loaded, the printer
moves the position of the roll to compensate for printhead nozzle usage and extend the lifetime of each
printhead. This is an automatic behavior, but you may notice that the front and rear rolls change position slightly
between rolls.

A CAUTION: Do not touch the printhead nozzles.

=)

A CAUTION: Do not put the printhead down on any surface for any reason.

X TIP:  Printheads are best preserved inside the printer. Moreover, if you remove the printheads, the printer will
need to be recalibrated whenever you put them back. Therefore you are recommended not to remove them
unnecessarily.

Printhead status
e  OK: The printhead is working normally.
e  Missing: No printhead is detected in the slot.
e  Replace: The printhead has been identified as faulty. It should be replaced by a new or working printhead.

e  Reseat: The printhead has been identified as faulty, but removing and reinserting it may perhaps solve the
problem.

e  Remove: The printhead needs to be removed.
e  Printhead replacement incomplete. Restart it.

The printhead did not complete the replacement procedure. You must restart the replacement and fully
complete it.

e If the warranty status is Out of warranty, this indicates that the warranty conditions have expired (for
example, ink consumption exceeds the warranteed limit).
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[%f NOTE: If a printhead is out of warranty, one of three possible status values may be seen in its health
gauge:

—  OK: The printhead can print normally.
—  Monitor IQ: Print quality may not be maintained in all prints.

—  Recover: You are recommended to use enhanced printhead recovery on that printhead (see Enhanced
printhead recovery on page 151).

If the warranty status is See warranty note, this indicates that the warranty conditions have been breached
(for example, expired or non-HP ink has been used).

You can check the warranty status in the printer information app.

See the limited warranty document provided with your printer for details of the warranty implications.

Printhead part number

The HP 841 printhead has the part number C1Q19A.

Replace printheads

Printheads rarely need to be replaced, but the front panel will tell you when a printhead is failing or has reached
the end of its life.

Alternatively, a test print may indicate a printhead problem before the printer detects it.

A CAUTION:  Avoid touching pins, leads, and circuitry when handling printheads, because these elements are
sensitive to electrostatic discharge. Such devices are called ESD-sensitive devices. See Glossary on page 182.
Electrostatic discharges are one of the main hazards to electronics products. This type of damage can reduce the
life expectancy of the device.

[Q IMPORTANT:  Recalibrate the printer after any printhead replacement (see Calibrate print bar on page 149).
Make sure you have the right paper for the calibration loaded before replacing the printhead. Use gloves when
handling any component of the ink system.

1. Ensure that all ink cartridges are at least 25% full.

2. Start the printhead replacement from the front panel: tap @ , then the Printhead tab, then Replace.
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3. Locate the top-stacker cover.
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6.  Open theinternal cover.

8.  Pull the latch to place it on the cover.
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sing the handle.

9.  Extract the printhead, u

10. Slowly remove the protective caps from the new printhead in the order shown below.

ENWW
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clipping it into place.

rientation,

to

171. Insert the new printhead in the correc

12. Close the latch.
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13. Close the blue handle.

14.

15.

16. Close the top-stacker cover.
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17.

18. Tap Continue and wait about 32 minutes while the printer performs automatic calibrations and checks.

19. Make sure that you comply with all applicable federal, state, and local regulations when disposing of ink
system consumables.

Printhead maintenance
The printer and the maintenance cartridge clean the printheads automatically.

Avoid removing printheads unnecessarily.

Printhead troubleshooting
1. Check that you have the correct type of printhead (model number).
2. (Check that you have removed the orange protective caps from the printhead.

Check that the printhead is correctly oriented: compare it with the others.

W

Check that you have closed and latched the printhead cover.

5. If you still have problems when printing, see Print quality on page 146.

ENWW Print bar
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Cleaning container

The cleaning container is a replaceable part that collects waste ink in liquid form, with a capacity of about 2 liters.

The cleaning container is designed to keep the printer's waste ink from damaging the printer and dirtying its
surroundings.

In order to achieve these objectives, you must ensure that it is correctly installed and maintained, changing it
when prompted by the front panel.

*} TIP:  You are recommended to wear gloves when replacing the cleaning container.

Always replace the cleaning container with the printer switched on, otherwise the counters may not work
properly.

If the printer continues operating while the container is incorrectly installed or connected, HP will not be
responsible for any resulting damage or cleaning expenses.

You can check the cleaning container status in the front panel.

Cleaning container status
e  Ready
e  Missing: The cleaning container is not detected.
e Almost full: This is estimated by the printer.

e  Full: The printer has stopped printing. It will continue after the cleaning container has been replaced.

Cleaning container part number

The HP 841 cleaning container has the part number F9J47A.

Replace the cleaning container
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1.  Atthe front panel, tap ,then g , then Cleaning container > Replace.

2. Locate the cleaning container.

]

3. Extract the cleaning container: lift it a little, then pull it out.

¥ TP of you leave the printer without a cleaning container for long, some drops of liquid may escape and
stain the floor. Try to replace it rapidly.

4.  Remove the packaging from the new cleaning container.

5. Insert the new cleaning container in place of the old one.

%}9 NOTE: If youinsert a cleaning container that has been used in another printer, the Almost full warning will
be unreliable.

6.  The printer checks the installation.

7. Make sure that you comply with all applicable federal, state, and local regulations when disposing of ink
system consumables.

Cleaning container troubleshooting

If the cleaning container is correctly installed but the printer does not detect it, first try taking it out and putting it
back again. If that fails, call your support representative.
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Maintenance cartridge

The maintenance cartridge cleans and maintains the printheads, and stores waste ink.

The maintenance cartridge contains a roll of cloth, which is used to clean the printheads. It has a total capacity of
500 wipes (cleaning operations). A heavy user will need to replace it about every 2 months.

The printer will refuse to start a print job if it detects the end of the cleaning roll. You should then replace the
maintenance cartridge with a new one.

X TIP: You are recommended to wear gloves when replacing the maintenance cartridge.

Maintenance cartridge status
e  Ready
e  Missing
e Almost finished

e  Finished

Maintenance cartridge part number

The HP 841 maintenance cartridge has the part number F9J48A.

Replace the maintenance cartridge

!@9 IMPORTANT:  Be ready with the new maintenance cartridge before starting the replacement. Once the cartridge
is moved to the replacement position, you have 40 seconds to change it. If you exceed that limit, the
maintenance cartridge is automatically moved back so that the printheads do not become dry. If the front panel
shows an error, close the service door.

1. Remove the packaging from the new maintenance cartridge.

2.  Start the replacement from the front panel.
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3. When prompted by the front panel, open the maintenance cartridge door.

¥ IMPORTANT:  When removing a maintenance cartridge, remember that it contains ink. Therefore, wear
gloves and hold the cartridge by the handle.

4. Toremove the maintenance cartridge, grip the handle and slide it out.

5. Ifyouintend to insert a partially used replacement cartridge, make a note of the percentage of cloth
remaining, which is shown approximately on the side of the cartridge. You will be asked for this figure later.
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6. Insert the new maintenance cartridge into the slot.

2 IMPORTANT:  Be careful to insert the maintenance cartridge correctly.

7. Pushin the maintenance cartridge into place; do not use excessive force.

l%? NOTE: The front panel will not show the new maintenance cartridge until the door is closed.

8. Closethe door.

9.  Make sure that you comply with all applicable federal, state, and local regulations when disposing of ink
system consumables.

l%’ NOTE: In order to start printing, the printer needs all the ink cartridges, printheads, and maintenance cartridge
to be installed, and the printer window and maintenance cartridge door to be closed.

The front panel asks whether the cartridge is new or used. If used, you are asked to enter the percentage of cloth
remaining. This information is used by the printer to estimate when the cartridge will need replacing.

Maintenance cartridge troubleshooting

If the printer does not detect the maintenance cartridge that you have inserted, open the door and make sure the
maintenance cartridge is correctly inserted. If this does not solve the problem, contact your support
representative.
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Safe mode

ENWW

Under certain conditions, including printer operation outside of environmental specifications, and when a used,
refilled, or counterfeit ink cartridge has been detected, the printer will operate in safe mode. HP is unable to
warrant the performance of the printing system when operated outside of environmental specifications or when
a used, refilled, or counterfeit ink cartridge is installed. Safe mode is designed to protect the printer and the
printheads from damage due to unexpected conditions, and is in operation when the icon is displayed on the
printer’s front panel and by the Embedded Web Server and HP Utility.

For optimal performance, use original HP ink cartridges. HP DesignJet printing systems, including original HP inks
and printheads, are designed and engineered together to provide uncompromising print quality, consistency,
performance, durability, and value—uwith every print.

[:?’”r NOTE: This printer is not designed to use continuous ink systems. To resume printing, remove the continuous
ink system and install genuine HP (or compatible) cartridges.

[:;’/f’ NOTE: This printer is designed for ink cartridges to be used until they are empty. Refilling cartridges prior to
depletion might cause your printer to fail. If this happens, insert a new cartridge (either genuine HP or
compatible) to continue printing.

_*L% NOTE: Dynamic security enabled printer. Only intended to be used with cartridges using an HP original chip.
Cartridges using a non-HP chip may not work, and those that work today may not work in the future. More at:
http://www.hp.com/go/learnaboutsupplies.

Safe mode
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Introduction

The printer provides a single RJ-45 connector port for a network connection. In order to meet Class B limits, the
use of shielded I/0 cables is required.

The embedded Jetdirect print server supports connection to IEEE 802.3 10Base-T Ethernet, IEEE 802.3u
100Base-TX Fast Ethernet and 802.3ab 1000Base-T Gigabit Ethernet compliant networks. When connected and
powered on, the printer auto-negotiates with your network to operate with a link speed of 10, 100, or 1000
Mbps, and to communicate using full- or half-duplex mode. However, you can manually configure the link using
the printer's front panel, or through other configuration tools once network communication is established.

The printer can support multiple network protocols simultaneously, including TCP/IPv4 and TCP/IPv6. For
security, it includes features to control IP traffic to and from the printer and supports configuration of IP Security
(IPsec) protocols.

Control network protocols

The printer can simultaneously support multiple network communication protocols. This allows network
computers that may be using different protocols to communicate with the same printer.

Each protocol may require some configuration before the printer can communicate on the network. For some
protocols, required parameters are automatically sensed and user-specified settings are not needed. However,
for other protocols, there may be many parameters to configure.

Enable or disable network protocols

If a network protocol is enabled, the printer may actively transmit on the network even when there are no
computers on the network that use the protocol. This may increase network traffic. To eliminate unnecessary
traffic, you can disable unused protocols. Disabling unused protocols lets you:

e  Reduce network traffic by eliminating broadcast messages from unused protocols

e  Provide better control over who prints to the printer by eliminating users from other networks who might
route print jobs to this printer

e  Display protocol-specific error conditions for enabled protocols only

To disable unused protocols through the device’s control panel menu, see Front-panel menu items on page 85.
For other tools, such as system command access to the embedded Telnet server, see the HP Jetdirect Print Server
Administrator’s Guide for your print server model.
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Front-panel menu items

To access the printer network configuration settings, go to the front panel and tap

Gigabit Ethernet.

Menu item Sub-menu item Sub-menu item Values and Description

Information Print Sec Report Yes : Prints a report.

No (default): Does not print a report.

TCP/IP Host Name An alphanumeric string, up to 32 characters, used to
identify the device. This name is listed on the HP Jetdirect
configuration page. The default host name is NPIXXXXXX,
where xxxxxx is the last six digits of the LAN hardware
(MAC) address.

IPV4 Settings Config Method Specifies the method that TCP/IPv4 parameters will be

configured on the HP Jetdirect print server.

Bootp : Use BootP (Bootstrap Protocol) for automatic
configuration from a BootP server.

DHCP (default): Use DHCP (Dynamic Host Configuration
Protocol) for automatic configuration from a DHCPv4
server. If selected and a DHCP lease exists, DHCP Release
and DHCP Renew menus are available to set DHCP lease
options.

Auto IP : Use automatic link-local IPv4 addressing. An
address in the form 169.254.x.x is assigned automatically.

Manual : Use the Manual Settings menu to configure TCP/
|IPv4 parameters.

DHCP Release This menu appears if Config Method was set to DHCP and a
DHCP lease for the print server exists.

No (default): The current DHCP lease is saved.

Yes : The current DHCP lease and the leased IP address are
released.

DHCP Renew This menu appears if Config Method was set to DHCP and a
DHCP lease for the print server exists.

No (default): The print server does not request to renew the
DHCP lease.

Yes : The print server requests to renew the current DHCP
lease.

Manual Settings (Available only if Config Method is set to Manual ) Configure
parameters directly from the printer control panel:

IP Address : The unique IP address of the printer (n.n.n.n).
Subnet Mask : The subnet mask for the printer (n.n.n.n).

Syslog Server : The IP address of the syslog server (n.n.n.n)
used to receive and log syslog messages.

Default Gateway : The IP address (n.n.n.n) of the gateway or
router used for communications with other networks.

Idle Timeout : The time period, in seconds, after which an
idle TCP print data connection is closed (default is 270
seconds, 0 disables the timeout).
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Menu item

Sub-menu item Sub-menu item

Values and Description

Default IP

Specify the IP address to default to when the print server is
unable to obtain an IP address from the network during a
forced TCP/IP reconfiguration (for example, when manually
configured to use BootP or DHCP).

Auto IP : Alink-local IP address 169.254.x.x is set.

Legacy : The address 192.0.0.192 is set, consistent with
older HP Jetdirect devices.

Primary DNS

Specify the IP address (n.n.n.n) of a Primary DNS Server.

NOTE: This item appears only if Manual configurationis a
higher priority than DHCP in the Config. Precedence table,
configured through the embedded Web server.

Secondary DNS

Specify the IP address (n.n.n.n) of a Secondary Domain
Name System (DNS) Server.

NOTE: This item will appear only if Manual configuration is
a higher priority than DHCP in the Config. Precedence table,
configured through the embedded Web server.

IPV6 Settings Enable

Use this item to enable or disable IPv6 operation on the
print server.

Off : IPv6 is disabled.

On (default): IPv6 is enabled.

Address

Use this item to manually configure an IPv6 address.

Manual Settings : Use the Manual Settings menu to enable
and manually configure a TCP/ IPv6 address.

Enable : Select this item and choose On to enable manual
configuration, or Off to disable manual configuration.

Address : Use this item to type a 32 hexadecimal digit IPv6
node address that uses the colon hexadecimal syntax.

DHCPV6 Policy

Router Specified : The stateful auto-configuration method
to be used by the print server is determined by a router.
The router specifies whether the print server obtains its
address, its configuration information, or both from a
DHCPvV6 server.

Router Unavailable : If a router is not available, the print
server should attempt to obtain its stateful configuration
from a DHCPv6 server.

Always : Whether or not a router is available, the print
server always attempts to obtain its stateful configuration
from a DHCPv6 server.

Primary DNS

Use this item to specify an IPv6 address for a primary DNS
server that the print server should use.

NOTE:  This item will appear only if Manual configuration is
a higher priority than DHCP in the Config Precedence table,
configured through the embedded Web server.

Secondary DNS

Use this item to specify an IPv6 address for a secondary
DNS server that the print server should use.

NOTE: This item will appear only if Manual configuration is
a higher priority than DHCP in the Config Precedence table,
configured through the embedded Web server.
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Menu item Sub-menu item Sub-menu item

Values and Description

Proxy Server

Specifies the proxy server to be used by embedded
applications in the device. A proxy server is typically used
by network clients for Internet access. It caches Web pages,
and provides a degree of Internet security, for those clients.

To specify a proxy server, enter its IPv4 address or fully-
qualified domain name. The name can be up to 255 octets.

For some networks, you may need to contact your
Independent Service Provider (ISP) for the proxy server
address.

Proxy Port

Type the port number used by the proxy server for client
support. The port number identifies the port reserved for
proxy activity on your network, and can be a value from 0
to 65535.

Security Print Sec Page

Yes : Prints a page that contains the current IPsec security
settings on the HP Jetdirect print server.

No (default): A security settings page is not printed.

Secure Web

For configuration management, specify whether the
embedded Web server will accept communications using
HTTPS (Secure HTTP) only, or both HTTP and HTTPS.

HTTPS Required: For secure, encrypted communications,
only HTTPS access is accepted. The print server will appear
as a secure site.

HTTP/HTTPS optional: Access using either HTTP or HTTPS
is permitted.

NOTE: The factory default setting depends on the print
server model.

IPSEC

Specify the IPsec or Firewall status on the print server.

Keep : IPsec/Firewall status remains the same as currently
configured.

Disable : IPsec/Firewall operation on the print server is
disabled.

802.1x

Enable Wipe
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Menu item

Sub-menu item

Sub-menu item

Values and Description

Reset Security

Specify whether the current security settings on the print
server will be saved or reset to factory defaults.

No (default): The current security settings are maintained.

VYes : Security settings are reset to factory defaults.

Link Speed

The link speed and communication mode of the print
server must match the network. The available settings
depend on the device and installed print server. Select one
of the following link configuration settings:

CAUTION:  If you change the link setting, network
communications with the print server and network device
might be lost.

Auto (default): The print server uses auto-negotiation to
configure itself with the highest link speed and
communication mode allowed. If auto-negotiation fails,
either TO0TX HALF or 10TX HALF is set depending on the
detected link speed of the hub/switch port. (A 1000T half-
duplex selection is not supported.)

10T Half : 10 Mbps, half-duplex operation.
10T Full : 10 Mbps, Full-duplex operation.
T00TX Half : 700 Mbps, half-duplex operation.
T00TX Full : T00 Mbps, full-duplex operation.

T00TX Auto : Limits auto-negotiation to a maximum link
speed of 100 Mbps.

T000TX Full : 1000 Mbps, full-duplex operation.

Link configuration methods

ENWW

The printer supports 10, 100, or 1000 Mbps network link speeds using full-duplex or half-duplex communication
modes (a 1000T half-duplex selection is not supported). By default, it will attempt to auto-negotiate its link

operation with the network.

When connecting to network hubs and switches that do not support auto-negotiation, the printer will configure
itself for 10 Mbps or 100 Mbps half-duplex operation. For example, when connected to a non-negotiating 10
Mbps hub, the print server will automatically set itself to operate at 10 Mbps half-duplex.

If the printer is not able to connect to the network through auto-negotiation, you can set the link setting by one
of the following methods:

The front panel

The Embedded Web Server

The Telnet interface, through a system command prompt

Network management tools such as HP Web Jetadmin

A TFTP (Trivial File Transfer Protocol) configuration file that is downloaded, for example, from a BootP or
DHCP server

Link configuration methods
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Troubleshooting

|0 Configuration page

The 10 Configuration page provides comprehensive print server status. It is an important diagnostic tool,
especially if network communications are not available. For a description of messages that may appear on the 10
Configuration page, see the HP Jetdirect Print Servers Administrator’s Guide for your print server model.
To print the 10 Configuration page, go to the front panel and tap {16:} , then Connectivity > Print Connectivity
Configuration.
To verify correct operation:
1. Print an 10 Configuration page to check for status messages.
2. Inthe upper section of the 10 Configuration page, look for the status message I/0 Card Ready.
3. If1/0 Card Ready appears, the print server is operating properly. Proceed to the next section.

If a message other than I/0 Card Ready appears, try the following:

a.  Turnthe printer off and then on again to re-initialize the print server.

b.  Check that the status indicator lights (LEDs) are providing proper status.

See the HP Jetdirect Print Servers Administrator’s Guide for your print server model to interpret and troubleshoot
other messages.

Reset network parameters

If you accidentally misconfigured the printer’s network settings, they can be reset to factory default values by

tapping , then @ ,then {C}, then Restore factory settings.

A CAUTION: A factory-installed HP Jetdirect X.509 certificate will be saved during reset to factory default values.
However, a Certificate Authority (CA) certificate that has been installed by the user to validate a network
authentication server will not be saved.

Link troubleshooting
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The printer has status lights (LEDs) beside the network connector that indicate the link status and network
activity.

e  When the green light is on, the printer has successfully linked to the network.
e  When the yellow light is blinking, there is network transmission activity.

If the printer does not successfully connect to the network:

e  Both LEDs will be off.

e  LAN Error—Loss of Carrier will be indicated on the 10 Configuration page.
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In this situation, try the following:

1.
2.

6.

Check the cable connections at both ends.
Consider replacing the cables by known good ones.

Consider switching to another network connector in the network switch, hub, or device to which the printer
is connected.

Manually configure the link setting to match the port configuration of the network hub or switch. For
manual configuration methods, see Link configuration methods on page 89. Turn the printer off, then on
again, to re-initialize the setting.

Print an 10 Configuration page and check link settings.

Item Description

Port Config If the printer is properly linked, this item has one of the following values:
° TOBASE-T HALF: 10 Mbps, half-duplex
° TOBASE-T FULL: 10 Mbps, full-duplex
° T00TX-HALF: 100 Mbps, half-duplex
° T00TX-FULL: 100 Mbps, full-duplex
e  1000TX FULL
If the printer is not properly linked, one of the following messages will appear:
o  UNKNOWN: The printer is in an initialization state.

e  DISCONNECTED: A network connection has not been detected. Check network cables. Reconfigure the
link settings, or restart the printer.

Auto Negotiation Indicates whether auto-negotiation for link configuration is on or off.

o  ON (default): The printer will attempt to automatically configure itself onto the network at the proper
speed and communication mode.

e  OFF: You must manually configure the link speed and communication mode using the front panel. Your
settings must match those of the network for proper operation.

In case of doubt or misconfiguration of link settings, reset the network parameters to their factory settings.

See Reset network parameters on page 90.

Communication failures between computer and printer

ENWW

Some symptoms are:

The front-panel display does not show the Received jobs message when you have sent jobs to the printer.
Your computer displays an error message when you are trying to print.

Your computer or printer hangs (stays idle), while communication is taking place.

Print jobs get stuck in your computer’s print spooler.

Your printed output shows random or inexplicable errors (misplaced lines, partial graphics, and so on).

Troubleshooting
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To solve a communication problem:
e  Ensure that you have selected the correct printer when sending your job.
e  Ensure that the printer works correctly when printing from other applications.

e [fyour printer is connected to your computer through any other intermediate devices, such as switch boxes,
buffer boxes, cable adapters, or cable converters, try using it when connected directly to your computer.

e  Tryanother network cable.
e Remember that very large prints may take some time to receive, process, and print.

e Ifyour printer displays warning or error messages that require action, take the required action before trying
to print.

Cannot access the Embedded Web Server

1. If you have not done so already, read Embedded Web Server on page 13.

2. Make sure that Embedded Web Server functionality is enabled in the printer: from the front panel, tap

@ , then Security > Connectivity > Embedded Web Server (EWS) > On .

3. Check the proxy configuration in your Web browser in case it is preventing communication with the printer.
4.  Ensure that the printer works correctly when printing or accessed from other applications.

5. If the printer displays warning or error messages that require further action, take the action to resolve the
problemes.

6. Ifall else fails, turn the printer off and on again with the power key on the front panel.

Cannot access the printer from the HP Utility

1. If you have not done so already, read HP Utility on page 12.

2. Make sure your printer driver is available and working correctly for the HP DesignJet Utility in Windows.

3. From the front panel, tap @ , then Security > Web services > Printing & management, and make sure

that it is enabled. If it is disabled, some parts of the HP Utility may not work properly.
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Print jobs take too much time to be received by the printer

ENWW

Very large prints may take some time to receive, process, and print. However, if there is an unusually long delay
after sending print jobs to the printer until they appear in the front panel’s job queue, there are various things
you could check:

Make sure the network cable connected to the printer is rated at least Cat5e.

Make sure that gigabit-speed networking equipment and cabling interconnects your computer client to the
printer.

Make sure that there are no network link issues. See Link troubleshooting on page 90.

Take into account that, in network deployments with IPSec security protocols enabled and configured in the
printer, network performance may be reduced due to the use of cryptographic algorithms to protect
network communications.

If you experience low-performance network issues when using tools such as HP SmartStream or third-
party RIPs, check that the RIP printing service and high-speed printing ports 9101 and 9102 are enabled in
Embedded Web Server > Networking > Other settings > High-speed RIP mode > Enable high-speed mode.

Try resetting the network configuration to its factory settings in order to get default settings that are
suitable for most standard network environments. See Reset network parameters on page 90.

You may also find it helpful to test connecting the computer to the printer directly, using a normal Ethernet
(Cat5e or Catb) cable point-to-point, without passing through an Ethernet switch or router. In this
configuration, the printer and the computer should both automatically change their IPv4 addresses to the
form 169.254.x.x . In this point-to-point configuration you can discard any issues caused by other network
equipment.

Troubleshooting
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Sending a job to print

There are various different ways in which you can choose to print, depending on your circumstances and
preferences:

From HP SmartStream: See the HP SmartStream documentation at http://www.hp.com/go/
smartstreampagewidexl/manuals/.

From a printer driver: Print any kind of file from a computer connected to the printer by network, using a
software application that can open the file, and a printer driver supplied with your printer. See Print from
the driver on page 95.

From a USB flash drive: Print a file directly from a USB flash drive. See Print from a USB flash drive
on page 98.

From a RIP: You can use a Raster Image Processor (RIP) program, run on a separate computer, to send jobs
to the printer. RIP software is available from various different companies. See your RIP vendor’s
documentation.

MFP only: Copy a file. See Scanning and copying (MFP only) on page 109.

Print a file that is already in the job queue. See Queue management on page 102.

Print by email.
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Print from the driver

This is the traditional way of printing from a computer. The correct printer driver must be installed on the

computer, and the computer must be connected to the printer by network.

When the printer driver has been installed and the computer is connected to the printer, you can print from a
software application by using the application's own Print command and selecting the correct printer.

[%& NOTE: When first printing, Windows automatically searches for the printer driver on the Internet (if the
computer is connected to the Internet). This means that you do not need to search for the driver yourself.
However, this process will install the driver without the rest of the software. Therefore, we recommend
installation using the install package that you can download from HP's website http://www.hp.com/go/

pagewidexlseries/support/drivers, so that all of the printer software is installed.

Check and change main driver settings

There are a relatively large number of print settings that you can use when printing with a printer driver, to try to
satisfy all requirements. When printing from an application, you can see the driver settings by clicking File > Print

and then Print options or Properties (depending on the application).

Copies: |1 H
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() Current page

(AN P PageWide XL 400095 PS2 v

Opages  [i-120
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Page Sizing & Handling @

[ size ‘ BijostEr- 1 ‘ @Mum‘p\e 1 ‘ Esoom |

Properties | Advanced
[IPrint in grayscale (black and white)

Comments & Forms

| Document and Markups

e Comments

£28%11,69 Inches

O Fit
() Actual size

(® Shrink oversized pages

() Custom Scale: 100 %

[l Choose paper source by PDF page size

Orientation:
) Auto portrait/landscape
(®) Portrait

O Landscape

PageSetup.. |

@O e
HP Pagellce X, 8000 a
e ettt oom

e ag00imar
P Pegevice 1L 2000MF
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Page10f 185

Cancel
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Fit to paper

Scale: Custom

t mm v
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Cancel O]

{} TIP: In general you are recommended to use the default settings unless you know that they do not meet your
requirements. The printer will apply its own policies regarding roll and paper to choose the most suitable for your

job.

TIP:  Windows only: If you intend to reuse a particular group of settings repeatedly, you can save those settings

under a name of your own choice and recall them later. A saved group of settings is known as a quickset.
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- x

Paper/Quaity | Layout/Output | Color | Job Storage | Services | Advanced |

Quick sets:
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| Use printer settings . | Rendering resolution (ppi): 500
Printing resolution (cpi): 1200 x 1200
@ [show preview before printing

o

The printer drivers support any accessories such as a stacker or folder connected to your printer. The printer’s
default output is also the driver's default output. However, from the driver you can change the output destination
and other options such as the folding style, collation, and first or last page on top.

- x

Paper/Quaity | Layout/Output | Color | Job Storage | Services | Advanced |

Quick sets:

| Factory defaults v [ sawve | | Deete
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() % of actual size:
100
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Copies ] Roll width: | From printer
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Roll Options
Page Order: | First page on top v [ cutter offin multi-page job
Remove blank areas
T -
["]Remave margins between pages
Folding style: |Predefined 1 v
@ Show preview before printing
ok [ coos 1[ Aow |

Job storage and PIN printing

Job storage allows jobs to be stored and then printed when required, it also provides features for setting print
jobs as private, with a personal identification number (PIN). To access job storage features, open the printer
properties, and then click Printing Preferences. Click the Job Storage tab, where the following job storage
features are available:

e  Print and store: After a job has printed, it is stored in the printer; more copies can then be printed from the
front panel.

e  Print and delete: Once printed, the job is automatically removed from the printer.

ENWW Print from the driver 97



98

e  Retrieve from front panel (personal job): Use the personal job printing feature to specify that a job cannot
be printed until you release it from the printer's front panel.

To preview it in the Embedded Web Server, you will need to enter the PIN.

e  Retrieve from front panel (private job): Use the private printing feature to specify that a job cannot be
printed until you release it with a PIN. First, click Retrieve from front panel (private job), after which the PIN
to Print checkbox will be available. If checked, a 4-digit personal identification number must be set. The PIN
is sent to the printer as part of the print job. After sending the print job, use the PIN to print the job. Once
printed, it is automatically removed from the printer.

To preview it in the Embedded Web Server or in the front panel, you will need to enter the PIN.

X TIP:  Define a user name and a job name in the job storage tab for easy identification in the job queue.

Print from a USB flash drive

1. Insert a USB flash drive containing one or more TIFF, JPEG, HP-GL/2, RTL, PDF, or PostScript files into the
printer's USB port.

-
e

B NOTE:  To print PDF or PostScript file, you must have a PostScript printer.

E;‘"{ NOTE: The use of USB flash drives with your printer may be disabled by the administrator.

2. Atthe front panel, go to the home screen and tap ﬁ .

You can tap folders to browse their contents. Files are shown as document thumbnails, and you can
preview a file by tapping the preview icon. When the preview is displayed, you can zoom in and out. Files

that cannot be printed are indicated with| &) | .

3. Select a file to be printed. Multipage documents are supported only in PDF files; in this case, you can also
select a page to print.

4.  The list of print-from-USB quicksets is displayed. You can choose and/or edit one of the quicksets for the
selected job.

The following settings are available:
o  Quickset name allows you to name the quickset you are working with.

e  Qutput scale allows you to resize the print in two different ways: to a percentage of its original size, or
to fit a particular paper size. The default is 100% (its original size).

e  Print quality allows you to set the print quality to Lines/Fast, Uniform areas, or High detail.
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e  Color options allows you to choose color or grayscale.

e  Paper source allows you to specify printing on roll 1 or roll 2, or you can choose Save paper, which
automatically chooses the narrowest roll on which the print will fit (if two rolls are loaded).

[“2? NOTE: The printer setting Roll width selection has two values: Print on same width only and Print on
same width or wider. When Print on same width only is selected, each page is printed only on a roll
with the same width as the page.

e  Output destination allows you to direct output to the stacker (the default) or the basket.
e  Page order allows you to choose first page on top, or last page on top.
e  (ollate allows you to turn collation on or off.

e  Rotation allows you to rotate the print by any multiple of 90°, or you can choose Automatic, which
rotates the print automatically if that will save paper.

e  Printer margins allows you to change the default printer margins.

e  Storage mode offers two options, print and delete (the job is not retained in the job queue) and print
and store (the job is retained in the job queue).

e  Folding style allows you to select the folding style when the folder is installed. To use the folder, you
must select Folder in the Output destination setting.

e  (utter allows you to disable cutting between copies or at the end of the job. You can change the

default behavior by tapping @ , then Job management > Cutter off.

e  Alignment allows you to decide the position of the image on the roll.

[%”f NOTE: If you edit a quickset after selecting a job, the changed settings are applied only to the current job
and are not saved permanently. You can change any of your own quicksets permanently by tapping {) on

the quicksets screen, or by tapping @ , then Print, Scan & Copy quicksets > Print from USB quicksets.

[ NOTE:  The factory quicksets cannot be modified.

5. When you are satisfied with the quickset settings, tap OK to continue.

6.  Ascreen with the following settings appears: Copies, Page order, and Collate. You can check and change
them in this step, regardless of the settings in the quickset. Tap Print to continue.

7. After printing, you can choose to print another file or go to the job queue. If you print another file
immediately without returning to the home screen, the temporary settings used for the previous file are
used again.

Print by email (HP ePrint)
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This option is disabled by default, but can be enabled from the front panel by tapping @ , then Connectivity

> HP Connected > HP ePrint connectivity. You can also configure HP ePrint from the front panel's HP Connected
screen.

When enabled, the HP ePrint icon is added to the front panel as shown below:

Print by email (HP ePrint)
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_&\ HP Maintenance Kit PMK3-DRA...

About printer Usage Settings User’s guide

e

Print Sean Copy Job queue

b

HP ePrint

A =
You can find your printer's email address by tapping the new icon. If you want to change the address or restrict its
use, you can do so from http://www.hpconnected.com.

In this way, you can print from anywhere with an Internet connection, without needing any printer driver. There
are a few limitations that you should bear in mind:

e  The attached files to be printed must be in PDF, JPEG, or TIFF formats.
e  The maximum file size is 10 MB, but your email server may have a lower limit.

e  Files are printed in the original document size (at 100% scale), in normal quality, in color, and normally in
portrait orientation (some printers may offer autorotation).

Select print quality

The printer has three print-quality modes which have been designed, as their names indicate, to match the
specific needs of different kinds of images.

Although all print-quality modes are for 1-pass printing (in contrast to HP DesignJet printers), several
parameters such as print speed, color strategy, and image processing have been optimized for each case.

Refer to the print-mode table and diagram below for guidance on selecting the most appropriate print mode for
your purposes.

Recommended print
If the image content is... mode You will obtain...

Monochrome or color lines and text

A Lines/Fast HIigh-quality lines with maximum productivity
Any content if maximum productivity is needed

More uniform and saturated colors for long-

B Large areas of uniform colors Uniform areas ) o
distance viewing

Text or lines on top of color backgrounds
C High detail
Highly complex drawings with plenty of detail

Smooth background with fine detail in lines and
text

[%F NOTE: The intention of the Lines/Fast mode is twofold: it can be used for images with only lines and text, or for
any kind of image when you need maximum productivity.
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6 Queue management

e  Job queue introduction

° Job queue actions

e  Job gueue options

e  Default printing preferences

e Jobdeletion

° Job queue in the Embedded Web Server
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Job queue introduction

Tap “ on the home screen to view the job queue on the front panel. You can also view the job queue in the

Embedded Web Server: see Job queue in the Embedded Web Server on page 108.

MFP only: You can choose Print & Copy queue or Scan queue from the tabs on the left of the screen. The job
gueue page shows all jobs that are available in the selected job queue.

The print queue includes jobs that are being received, parsed, rendered, printed, already printed, and so on.

Print & copy queue QO -

—_—
fﬂ Up next o v House map

Now printing 00:00:73

PAGES COPIES TOTAL

06/100 | 02/10 1.000

L. Onhold D A

PresentationVé
Martin Jones e 4.}:,‘

—
& History o~

Today Dec 09

@ A04_Floor
Albert Davis @ SEVTBY

== john Smith

The scan queue (MFP only) includes jobs that are being scanned and jobs that have been scanned.

Tap 4 to show the toolbar. You can see all the job details by selecting the job, including information about
status, pages, copies, total, and preview.

In an active queue, the job you are printing appears in the middle of the queue, with printed jobs below and jobs
to be printed above. You can scroll up and down. Once scrolled, the queue remains static and does not move
automatically.

Jobs in the left pane are divided into four categories (Up next, Now printing, On hold, and History) in chronological
order starting from the top. On hold is shown only when there are one or more jobs on hold. Below the job name,
you can see its status:

Up next
e  Waiting to process: The job has been received by the printer and is waiting to be rendered.
e  Processing: The printer is parsing and rendering the job.
e  Waiting to print or Paused: The job is processed and waiting for the print engine to be ready to proceed with
printing.
Now printing

The job is being printed.

e  Paused: Thejob is paused.

[Z?’”f NOTE: Sometimes, while printing, you may see a Self-servicing status, which means that the printer is
performing some task such as paper type change or print mode change between pages of the same job.
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On hold
The job will not be printed until you take some action. You should respond in one of the following ways:

e  Onhold: Private job: Enter the PIN required to print the job. The job will be deleted from the queue after
printing.

e  Ohhold: Personal job: The job is not automatically printed: you must select it from the queue. No details
can be seen.

e  Onhold to preview: The job is not automatically printed: you must select it from the queue.

e  On hold for paper mismatch: Load the paper required by the job.

e  Onhold for output mismatch: Enable or change the output required by the job.

e  On hold for accounting: Enter an account ID to be used for the job.

e  Onhold: Recovered job: After a printer recovery, some jobs that were not printed are kept on hold.

e  Onhold for supplies: The printer needs paper, ink cartridge, printhead, cleaning container, or maintenance
cartridge to be replaced.

History
e  Printed: In chronological order, divided into today, yesterday, last week, and so on.
e  Canceled: Canceled by the user.

° Failed: The job has failed for one or more reasons.

Job queue actions

Some of the actions in the job queue are determined by the settings selected. Some default settings may be
worth changing, depending on your environment. To do so, tap @ in the home screen, then Job

management. Alternatively, in the job queue app, tap the ... button on the top right, then Settings.

Pause the job queue

You can pause the job queue by tapping m and resume by tapping [O] . The pause takes effect at the end
of the page that is currently printing.

Reprint

In the History section, select the job you want to reprint and tap Reprint. In the next screen you can select the
number of copies, collated or not, page order, source, and destination.

Print next

If you want to upgrade a job in the queue to be printed immediately after the currently printing job, select the
desired job and tap the Print next button.
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Print now

If you want to upgrade ajob in the queue to be printed immediately, interrupting the currently printing job, select
the desired job and tap the Print now button.

99

NOTE: To enable this action, tap @ in the home screen, then Job management and activate Enable print

now.

See job details

Tap the name of the job to show its details in the right pane, including information about status, pages, copies,
total, and preview. Scroll down as necessary to see all of the information.

PresentationV6 ‘ < > ‘...

999 | /1.852

By tapping the thumbnail, you can navigate over all pages of the job. Use the ... to show or hide the toolbar. From
there you can zoom in and out and see more information about each page.

Roll policies
If two rolls are loaded, both of which are suitable for the job, the roll is chosen according to your preferences.
e Increase productivity: To increase the productivity of the printer.
— Job autorotation: The printer can rotate a job automatically in order to save paper.

e  Automatic roll selection: When the job arrives with the roll not defined, the printer selects the rolls
according to the following settings.

—  Roll width selection: The printer can be more or less restrictive when selecting the roll width on which
to print. You can select to print on the same width only (each page prints on a roll with same width as
the page) or to print on the same width or wider (each page prints on roll with same width as the page
or wider).

—  Avoid printing on a wider roll: Avoid switching to a wider roll when the defined rolls are depleted. Only
applies when Roll width selection is Print on same width or wider.

—  Use most depleted roll: When there are two or more rolls with the same paper type and width, the roll
selected is the roll with less paper.

—  Paper type protection: You can avoid printing accidentally on special paper types by protecting them.
Protected types are eligible for printing only when paper type or roll are specified in the job.
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Solve paper mismatch

If the paper currently loaded in the printer is not suitable for a particular job or page, the printer can

automatically solv

e the conflict or give a number of choices depending on the printer policies. Such a conflict may

be caused by a job sent to the printer with no specific roll or paper type assigned to it, or by a roll coming to its
end during printing. The following options are available in the paper mismatch settings menu; you can reach this

menu from the job queue by tapping {_} , then Mismatch actions; or by tapping @ , then Job management

> Mismatch action

Settings

Print, scan and
copy quicksets

Default printing
configuration

Print from cloud
preferences

Optimize print
quality

Optimize scan
Job Management

Paper Source

S.

Mismatch actions

it Paper mismatch Pause and ask A

) Pauseand ask
Job queue pauses and printer asks for
intervention

© Hold job and continue with next
The job or pages that generate the mismatch
are put on hold, and the printer continues with
the next queued job. This can disrupt the job.

© Print anyway

Use any roll to continue printing. Rolls
contaning protected paper types will
not be used.

4. Paper waste and clipping may occur.

e  Pause and ask (the most restrictive option): Printing stops until the correct paper is loaded. This option is
recommended when the printer is attended. A message appears, asking what you want to do: cancel the
job, print anyway, put on hold, or load paper. These options are also available in the job queue.

@ Paper mismatch

Job PresentationV6 page2
cannot be printed.

Assigned roll width and paper type not
loaded in selected roll ID.

Inroll 1, load: Glossy 36™

m Put on hold Load paper

e Holdjoband

continue with next: Put mismatched jobs on hold until the correct paper is loaded, and

continue printing the rest of the job queue. The printer sends an alert whenever a job is put on hold. This
option is recommended when the printer is unattended, even though the integrity of a job may be
disrupted, to avoid stopping the queue. Once the paper required for the job is loaded, the job or pages are

automaticall

y resumed.

e  Print anyway (the least restrictive option): Print on whatever paper is loaded. The printer will choose the roll

to print acco

rding to the following criteria: first where the page fits and then the same paper type. This

option will never select a paper type that has been protected.

Solve output mismatch

The selected outp
empty for ajob th

ut for a particular job is not available for some reason: output disconnected, detached, full, not
at requires it to be empty, size/type/length not supported by that output, or folder is offline.
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The following options are available in the paper mismatch settings menu; you can reach this menu from the job

queue by tapping {C} , then Mismatch actions; or by tapping :Cé} , then Job management > Mismatch actions.

e  Putjobs on hold: Put mismatched jobs on hold until the correct output is available, and continue printing
the rest of the job queue. The printer sends an alert whenever a job is put on hold. This option is
recommended when the printer is unattended, to avoid stopping the queue.

e  Pause job queue and ask: Printing stops until the correct output is available. This option is recommended
when the printer is attended. A message will appear asking what you want to do: cancel the job, print
anyway, put on hold, or load paper.

Job queue options

To change the job queue options, tap @ , then Job management > Job queue.

You can select the maximum number of printed jobs to have in the queue, when to delete printed jobs, and
whether to delete jobs on hold after a specified time.

MFP only: You can also select whether or not to have a scan queue.

Default printing preferences

At the front panel, tap @ , then Default Printing configuration to define the default properties of jobs sent to
your printer from remote locations.

You can define settings in the following areas: Print quality, Color, Paper, Margins, HP-GL/2, PostScript, Print
retrieval.

[:?’”r NOTE: In the paper options you can define settings such as the default size and rotation. This kind of setting

can be modified for each job by driver, HP SmartStream, quickset, and so on. But the mirror option is not
available in HP SmartStream or quickset; so, if it is activated, all jobs printed by any path, except from the printer
driver, will be affected.

If the print is mirrored, check the status of this setting: Default printing configuration > Paper option > Mirror
image.

Job deletion

ENWW

If the printer runs out of storage space for new jobs, the oldest printed jobs are automatically deleted from the
gueue.

You can request that printed jobs should be automatically deleted from the queue when the total number of
printed jobs exceeds a specified limit (the maximum number in the history setting), or when the jobs were
printed more than a specified time ago (clear history settings).

To delete jobs on hold, the setting Delete jobs on hold allows you to define the time after which these jobs will be
removed (2-48 h).
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To delete a job manually, select the job and tap Delete in the footer. To delete all jobs, tap Delete all jobs in the ...
menu; the whole job queue will be deleted.

The delete option deletes the job from the queue, while the cancel option cancels the job but leaves it in the
gueue, marked as Canceled by the user in the history category.

To cancel a job, tap the job name on the list and then tap Cancel job at the bottom right. If you are not in the job
gueue screen, you can cancel a job while printing by tapping X.

[%9 NOTE: If youtap X, you cancel the currently printing job only.

Job queue in the Embedded Web Server

You can access the Embedded Web Server from any computer with an Internet connection, by entering the IP
address of the printer in your Web browser; the job queue is shown by default in the first window that appears.

The Embedded Web Server can show up to 32 jobs. The filename, status, and time of creation are shown for
each job; there is no job preview.

(B 1 rass sy Rilgiglgll 4

Main

Job center
Job queve.
status,
Supphes
History
Usage
Accounting

Printer status: 3, Very low ink: Black {3
I T e e e 2R
Job queue =

@ cancel | & reprint | 0 row | B Resume | @ Retesn

W | File name Status Date.

Job 2 On hold for preview =
minions. jpg Job has been canceled S/292017, 4:18:58 AM
Job 12 Job has been canceled 57282017, 3:46:00 AM
PDF Job Job has been canceled 572572017, 3:37:23 AM
TIFF ot Job has been canceled S/20/2017, 3:35:27 AM
POF Job Job has been canceled 5292017, 33433 AM
PDF Job Job has been canceled S/28/2017, 3:22:27 AM
Job 12 Printed 5/2872017, 3:20:55 AM

| PDFJob J0b has been canceled 57282017, 30234 AM
Job 11 Job has been canceled 5/292017, 2:36:30 AM

Job2 Job has been canceled S/202017, 2:35:08 AM
POF Job Printed 52672017, 5:58:26 AM
TIFF job Printed S/26/2017, 5:42:56 AM
POF Job Printed 572672017, 5:33:13 AM
- minions. g Printed S252017, 32112 AM
C ‘minions jpg Printed 57252017, 3:18:23 AM
riions g Prined 5230017, 52625 30
e 53 Prrtes s232017, 62563 40 |

Available functions

Cancel: Cancel a job, even if it is already printing.

Reprint: Reprint a job, with the same settings as before, except that you can change the number of copies.
Hold: Put on hold a job that was sent to print.

Resume: Release for printing a job that was previously put on hold.

Refresh: Update the list of jobs (it does not update automatically).

[%9 NOTE: If the admin account has been activated, you can see the job queue but you must give the password to
perform any of these functions.

¥ TIP:

If the job queue does not appear, you may need to clear the browser cache.
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7  Scanning and copying (MFP only)

° Quicksets
° Scanning
e  (Copying

° Scanner preferences

e  Scanner troubleshooting

e  Scanner diagnostic plot
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Quicksets

Scanning and copying use quicksets. A quickset is a named group of settings with default values defined, which
helps you to be more efficient and is convenient for inexpert users.

Factory quicksets

The printer comes with some factory quicksets already defined, designed to support typical user requirements.
Quicksets can be used for scan, copy, and print jobs.

User quicksets

Depending on the permissions set in your printer, you can create, delete, reorder, or change a quickset. To do
these things, tap Print, Scan & Copy quicksets in the settings application, or tap Manage quicksets from the scan,
copy, or print workflow.

Your own quicksets can be duplicated, edited temporarily or permanently, and deleted. Factory quicksets can
only be duplicated.

You can reorder the quicksets from Manage guicksets. Tap an entire quickset and drag it to the desired position.
The Last settings quickset is always shown first.

Edit quicksets

e
a

-
B&W lines to singll  Color lines to single= Color lines to multi
page PDF : page PDF : page PDF
1 |
}
) > | POF | |
J U |
1 [}
1 [}
L 300 dpi ) 200 dpi | L 200 dpi
| |
B Grayscale ! Colo ‘ 1 colo
L_‘ ayscale i u r i u or

Scanning

110 Chapter 7 Scanning and copying (MFP only) ENWW



& Ready i

Print Scan Copy Job queue

i =
2. Select the scan destination.

Scan destination

e @ ©

USB drive Network folder | P SmartStream Email
folder

e  Scanto USB flash drive
e  Scan to network folder (if a network folder has been added)
e  Scanto HP SmartStream folder (if installed)

e  Scanto email (if an email server has been configured)

3. Select an appropriate quickset for your scan job. Any quickset can be modified by tapping o . You can
select the file format, single or multiple pages, and change the default filename.

Scan configuration

Last settings (/] File format: Multi-page POF
2] Lines 200 dpi ] D
[ whitepaper [l Color B
() Separate single-page files
B&W lines (/) =
ooo
300dpi @ Onemulti-pagefile
¥ [l Grayscale (/)
Color lines (/]
File name prefix: Scan_
T B z004pi
5% & color Sean_ =

Eg.: Scan_0001.pdf

To change a quickset permanently, tap ss e , then Manage quicksets.
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4. Insert the original, facing upwards.

Scan to network using: Color lines to single-page PDF

=) [

Scanning...

5. Pick up the original when the scanner releases it.

¥ TIP: Torelease the page, you can select automatic release in the quickset settings, or keep the original on
hold until you tap Release page or insert a new original.

6. One of the most useful options is the one to scan a multipage or single-page document.
e  Multipage: The result will be a single file containing all the scanned pages.
When scanning a multipage document, insert the next page when prompted.

Scan to network using: Color lines to multi-page PDF

Multi-page PDF

Release page Finish & Save
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e  Single-page: The result will be a single-page file for each scanned page.

When scanning a single page, the document is automatically saved. If you insert another page, a new
document is created.

Scan to network using: Color lines to single-page PDF

Release page

[’_5? NOTE: By tapping = s you can show or hide the toolbar, show or hide the background removal setting,
and change the scan settings for the following pages. Change the settings as you like and tap OK.

[’_ﬁf’ NOTE:  With the toolbar buttons you can zoom in and out, and see scanner information about the selected
page. In a multipage document, you can delete a page.

L%/r‘ NOTE: When you are scanning to a USB flash drive, the space remaining on the drive is displayed.

7.  Exit the scan by tapping Finish for single-page documents, or Finish & Save for multipage documents.

8.  Tap New scan to scan again with the same settings. Tap Job queue to see the status of the scanned jobs.
With USB viewer (only when scanning to USB) you can go to the USB flash drive to confirm that the job is
there and preview it.

v

Document successfully saved.
It is now safe to remove the USB drive.

= O e

New scan Job queue USB Viewer

Scan

The following settings are available in scan quicksets:
e  Quickset name allows you to name the quickset you are working with.
e Content type allows you to set the content type to Lines, Mixed, or Image.

e  Original paper type allows you to set the content type to White paper, Photo paper, Old/recycled paper,
Translucent paper, Blueprint, or Ammonia/old blueprint.

e  Blueprints invert allows you to invert blueprints (or not).
e  Auto-release original allows you to auto-release the page once scanned.

e Input size allows you to set the input size page to Automatic, Custom size, a list of the available loaded rolls
(Roll width), or a fixed list of standard sizes, by width and length (Standard size).
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If you select Custom size, two new settings are displayed:

—  Custom width allows you to set a specific scan area width, or enter 0 (zero) for automatic width
detection.

—  Custom length allows you to set a specific scan area length, of enter 0 (zero) for automatic length
detection.

e  Orientation allows you to set the page orientation to Landscape or Portrait when Input size is set to Custom
size, Roll width, or any Standard size except AO.

e  Positioning allows you to set the position of the original page in the input size area, when input size is not
automatic. The options are Top-left, Top-center, Top-right, Middle-left, Middle-center, Middle-right,
Bottom-left, Bottom-center, Bottom-right.

For example, if you are scanning an A1 original and the input size <ns1:XMLFault xmlns:ns1="http://cxf.apache.org/bindings/xformat"><ns1:faultstring xmlns:ns1="http://cxf.apache.org/bindings/xformat">java.lang.OutOfMemoryError: Java heap space</ns1:faultstring></ns1:XMLFault>